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Preface 
This preface is an introduction to the Exigen Workflow Installation Guide. 

The following topics are included in this preface: 

• Audience 

• Related Information 

• Typographic Conventions 

Audience 
This guide is intended for all users who install Exigen Workflow. 

To effectively use this guide, a good understanding of database systems and general computer 
terminology is required. 

Related Information 
The following table lists guides that provide related information about Exigen Workflow: 

Related Information 
Document title Contents 
Exigen Workflow User’s Guide Describes how to work with specific Exigen Workflow features. 

It is useful as a reference for the Exigen Workflow end user.  

Exigen Workflow Administrator’s Guides I-III Describes how to administer Exigen Workflow. Administrators 
can manage users within the system and change basic 
workflow features and project tables. It also describes several 
utilities within Exigen Workflow.  

Exigen Workflow Web User’s Guide Describes how to use the Exigen Workflow Internet solution. 

Exigen Workflow Web Administrator’s Guide Describes how to administer Exigen Workflow Web. 
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Typographic Conventions 
The following styles and conventions are used in this guide:  

Typographic styles and conventions 
Convention Description 
Bold • Represents user interface items such as check boxes, command buttons, dialog 

boxes, drop-down list values, field names, menu commands, menus, option 
buttons, perspectives, tabs, tooltip labels, tree elements, views, and windows. 

• Represents keys, such as F9 or CTRL+A. 
• Represents a term the first time it is defined. 

Courier Represents file and directory names, code, system messages, and command-line 
commands.  

Courier Bold Represents emphasized text in code.  
Select File > Save 
As 

Represents a command to perform, such as opening the File menu and selecting Save 
As.  

Italic • Represents any information to be entered in a field.  
• Represents documentation titles.  

<  > Represents placeholder values to be substituted with user specific values.  
Hyperlink Represents a hyperlink. Clicking on this field takes you to the identified place in 

this guide. 
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Chapter 1: Introducing Exigen Workflow 
This section introduces the Exigen Workflow system. 

The following topics are described in this section: 

• What is Exigen Workflow? 

• Exigen Workflow System Overview 

What is Exigen Workflow? 
Exigen Workflow is a Windows® based work management system that provides software for 
document imaging, indexing, routing, and archiving. Exigen Workflow is a customizable system 
enabling system administrators to create workflow applications to solve document management 
problems. 

Exigen Workflow System Overview 
The following diagram shows a graphical overview of Exigen Workflow: 
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Figure 1: Exigen Workflow system overview
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Chapter 2: Installing Exigen Workflow 
The following topics are described in this section: 

• Exigen Workflow System Requirements 

• Third Party Software 

• Exigen Installer Overview 

• General Installation Steps 

• Creating or Upgrading the Exigen Workflow Database Structure 

• Running Exigen Workflow 

• Modifying Exigen Workflow Components 

• Upgrading Exigen Workflow from a Previous Version 

• Installing Exigen Workflow in Silent Mode 

Exigen Workflow System Requirements 
For information on Exigen Workflow hardware and software requirements, see the Exigen Workflow 
readme file. 

Third Party Software 
The following third party software is required by several Exigen Workflow components and may be 
delivered as part of the main Exigen Workflow installation: 

Third party software used by Exigen Workflow components 
Third party software Owner Dependant Exigen Workflow components 
ABBYY FineReader Engine ABBYY Software House • FTS Preprocessor 

• Form OCR Server 
• generic OCR recognition 
• Enhanced Form OCR 

Adobe Libraries Adobe Systems 
Incorporated 

• Import Server when importing PDF files as 
images 

• Conversion Engine 
• E-Capture 
• Interactive Document Capture 

Centura Runtime Centura Software 
Corporation 

Exigen Workflow Windows based objects 

PCLTool SDK Runtime Page Technology 
Marketing Inc. 

E-Capture working with PCL files 

Axtel AX-4 Barcode Recognition 
Runtime 

Axtel Applied Technology • Barcode Server 
• Form OCR Server 
• Image Viewer 
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Third party software used by Exigen Workflow components 
Third party software Owner Dependant Exigen Workflow components 
Pegasus Smartscan Xpress 
BARCODE Runtime 

Pegasus Imaging Corp. • Barcode Server 
• Form OCR Server 
• Image Viewer 

ScanFix Runtime TMSSequoia • Image Enhancement Server 
• Image Viewer 

NED Image Printer Driver Northeast Data Corp. Exigen Workflow 

SPRINTA 2000 Driver for SQL 
Server 

i-net Software Exigen Workflow Web using SQL Server 

WDD Port Driver We Do Drivers Inc. Print Server 

If the preceding components are not included in the Exigen Workflow installation package, they can be 
ordered separately from Exigen.  

Exigen Installer Overview 
Exigen Workflow installation is performed by a tool named Exigen Installer. Exigen Installer is similar 
to a standard installation wizard but can be customized for each Exigen client according to its individual 
needs. Exigen Installer also verifies the compatibility of new Exigen Workflow components with those 
components that are already installed on the client's workstation and informs the user if 
incompatibilities or problem situations are detected. 

Exigen Installer is automatically installed on the client's workstation when the user runs the Exigen 
Workflow installation for the first time. When a user runs the Exigen Workflow installation repeatedly or 
upgrades the solution to a new version, Exigen Installer is not reinstalled. The version that is already 
installed on the client's workstation is used. 

Exigen Installer is also used for installing other Exigen solutions. 

General Installation Steps 
To install Exigen Workflow, proceed as follows: 

1. Insert the Exigen Workflow installation CD into your CD drive. 

2. If the installation does not start automatically, from the Exigen Workflow installation CD, launch the 
Setup.exe file located in the Windows directory. 

The Exigen Installer Setup window appears. 
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Figure 2: Exigen Installer startup window 

3. Wait while Exigen Installer verifies the list of installed Exigen Workflow components. 

The Exigen Installer Setup window is updated and displays the solution name and version. 
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Figure 3: Exigen Installer window displaying the solution name and version 

4. Click Next. 

If personalization information is required, the User Information window appears. 
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Figure 4: User Information window 

5. If the User Information window appears, enter the full user name and organization name. 

6. Click Next. 

The Select Installation Type window appears. 
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Figure 5: Selecting the installation type 

7. Select one of the following installation types as required: 
Installation types 
Type Description 
Typical Installs Exigen Workflow components that are required for most users. 

If this installation type is selected and the list of installed components displayed in the 
Selected Options window does not match requirements, to return to the Select 
Installation Type window, the user can click Back and select Custom. In this case, the 
list of components is preconfigured as in a typical configuration, but the user can modify 
the selection as appropriate. 

Custom Users can specify which Exigen Workflow components must be installed. 
If this option is initially selected, there are no components selected to install. However, if 
this option is selected after the Typical option is used, the list of components to be 
installed is preconfigured according to the typical installation type. 

8. If the typical installation type is selected, click Next and follow instructions as described in Finishing 
the Installation. 

9. If the custom installation type is selected, click Next and follow instructions as described in 
Customizing the Exigen Workflow Installation. 

Customizing the Exigen Workflow Installation 
If the custom installation type is selected, proceed as follows: 
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1. To change the location of Exigen Workflow setup files, in the Setup Folder window, click Browse 
and select the location. 

 
Figure 6: Setup Folder window 

The default location is the directory from which the Setup.exe file is launched. 

2. Click Next. 

The Exigen Workflow window appears, displaying all Exigen Workflow component groups. 
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Figure 7: Exigen Workflow window 

The list of component groups in the Exigen Workflow window you see may differ because Exigen 
Installer is customized for each customer. 

Each component group contains one or more Exigen Workflow components or other component 
groups. 

The Exigen Workflow window contains the following columns: 

Exigen Workflow window columns 
Column Description 
Component group Lists Exigen Workflow component groups that can be installed, upgraded, or 

uninstalled on the client's workstation. 
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Exigen Workflow window columns 
Column Description 
Remove Contains check boxes for uninstalling each component group. 

The appearance of check boxes identifies the status of the component group and 
actions to be taken with components as follows: 

Check box status Description 

 Some components of the component group are already 
installed on the workstation. 

 Typical selection of components in the component group 
is selected for removal from the workstation. 
Note: This option does not mean that all components in 
the component group are selected for removal. 

 Custom selection of components in the component group 
is selected for removal from the workstation. 

 No components of the component group are installed on 
the workstation.  

Install/Upgrade Contains check boxes for installing or upgrading each component group. 
The appearance of check boxes identifies the status of the component group as 
follows: 

Check box status Description 

 No components of the component group will be installed 
or upgraded. 

 Typical selection of components in the component group 
is selected for installing or upgrading on the workstation. 
Note: This option does not mean that all components in 
the component group are selected. 

 Custom selection of components in the component group 
is selected for installing or upgrading on the workstation.  

The Remove and Install/Upgrade columns may contain some additional component group 
information displayed to the left of the check box. This information usually shows the version or 
build number. 

3. To see a description of a component or component group, click ?. 
4. Select the component groups that must be installed, upgraded, or removed as required. 

5. To remove all installed Exigen Workflow components, in the Remove column, click Full. 
6. To remove all installed typical components in all component groups, in the Remove column, click 

All typical. 

This option has the same effect as selecting each individual check box in the Remove column. 

7. To install or upgrade all Exigen Workflow components, in the Install/Upgrade column, select Full. 
8. To install or upgrade all typical components in all component groups, in the Install/Upgrade 

column, click Select all. 

This option has the same effect as selecting each individual check box in the Install/Upgrade 
column. 
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9. To install the main Exigen Workflow documentation, in the Options component group, in the 
Exigen Workflow Documentation row, in the Install/Upgrade column, select the check box. 

10. To install documentation for the selected Exigen Workflow subcomponents, select the Install 
documentation for subcomponents check box. 

Additional documentation is provided for the following subcomponents: 

• Exigen Workflow Web 
• Task Oriented Workflow 
• Exigen Publisher Cabinet 
• Usage Logging Server 

11. To configure components in an individual component group, click Details. 

The list of components and subgroups in the selected component group appears. 

 
Figure 8: Example of components and subgroups in the Administrative Components group 

12. Configure components in the group as follows: 
• To install or upgrade a component, in the Install/Upgrade column, select the check box. 
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• To leave the currently installed component on the workstation, in the Install/Upgrade column, 
clear the check box. 

• To uninstall a component, in the Remove column, select the check box. 

You can also select both check boxes for a component. This means that the currently installed 
component will be uninstalled and the new version will be installed. 

Subgroups can be configured in the same way as the main Exigen Workflow component groups. 

13. To apply changes and return to the main list of Exigen Workflow component groups, click OK. 
14. To finish the installation, click Next and follow instructions as described in Finishing the Installation. 

Finishing the Installation 
If any of the following components is selected to be installed, additional installation windows appear: 

• Application Services 

• Automatic Queue Server 

For information on installing Application Services, see Chapter 8: Installing Application Services. 

For information on installing Automatic Queue Server, see Chapter 9: Installing Automatic Queue 
Server. 

After all required components are selected, to finish the installation, proceed as follows: 

1. Wait until Exigen Installer finishes checking discrepancies in the selected components. 

2. If information about any discrepancies is displayed, click Back and correct the selection as 
required. 

The Destination Folder window appears. 
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Figure 9: Destination Folder window 

The Destination Folder window is used to specify the destination directories for selected Exigen 
Workflow components. Some of the fields can be disabled if the related components are not 
selected. 

3. Select the following destination directories as required: 
Exigen Workflow destination directories 
Directory Description 
Exigen Workflow Folder Main Exigen Workflow destination directory. 
Exigen Workflow Web 
Root Folder 

Exigen Workflow Web destination directory. 

Exigen Workflow Web Dll 
Folder 

Destination directory for Exigen Workflow Web DLL files. 

Exigen Products Folder Exigen products directory. 

4. Click Next. 

The Selected Options window appears, listing all options the user selected. 
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Figure 10: List of selected actions 

5. Carefully review the list of actions. 

6. If you find any actions in the list that are incorrect or may damage your business environment, click 
Back and make changes to the component configuration. 

7. To accept the selected actions, click Next. 

The Ready to Install the Application window appears. 
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Figure 11: Ready to Install the Application window 

8. To revise the selected options, click Back and make any necessary changes to the configuration. 

9. To execute the selected actions, click Next. 

Exigen Installer removes, installs, or upgrades the selected Exigen Workflow components. 

When the installation is finished, a message box appears. 

 
Figure 12: Successful completion message 

10. Click OK. 
11. Set up a connection to the database server as described in Chapter 3: Setting Up the Database 

Connection. 
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Creating or Upgrading the Exigen Workflow Database 
Structure 

When Exigen Workflow is installed or upgraded and the connection to the database is correctly 
configured, the required Exigen Workflow tables must be created and populated with the default values 
in the database. If the database structure was previously created with an older Exigen Workflow 
version, database tables and records may need to be upgraded. To find out if the database structure 
must be upgraded in your business environment, consult Exigen Support Services. 

Before upgrading the database structure, it is recommended that you make a backup of the previously 
created Exigen Workflow database structure. 

To create or upgrade the Exigen Workflow database structure, proceed as follows: 

1. Select Start > Programs > Exigen Solution > Exigen Workflow > Workflow DB Startup. 

The Workflow Database Installation/Upgrade Wizard window appears. 

 
Figure 13: Workflow Database Installation/Upgrade Wizard window 
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The Workflow Database Installation/Upgrade Wizard creates or upgrades Exigen Workflow system 
tables by running data structure creation scripts.  

2. Enter values in the following fields: 
Connect dialog fields 
Field Description 

Database Exigen Workflow database name if you access the database through client software, 
or the Exigen Workflow database data source name (DSN) if you use the ODBC 
connection. 

User  Database server user login name. 

Password Database server user password. 

3. To connect to the database, click Connect. 
4. To enable extended user authentication and authorization in this database, select the Use 

extended security check box. 

The extended authentication can be performed on a database user or Windows domain level. 

Note: Enabling the Use extended security check box requires administrator rights. 

5. Click Run. 

If you are using an Oracle, DB2 z/OS, or AIX database, the Server window appears. 

 
Figure 14: Server window 

6. In the Server window, select a tablespace and click OK. 

The application creates or upgrades the Exigen Workflow system tables. 

7. Wait until the Exigen Workflow system tables are created or upgraded. 

8. To view the log file, click Log File. 
9. To exit the Workflow Database Installation/Upgrade Wizard, click Finish. 
10. If an Oracle database is used and Workflow DB Startup is not run on the workstation, the projects 

cannot be imported. To enable the projects to be imported, add the following line to VISI.INI file 
after the DBS_MASTER entry: 
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DBS_ORA_SCHEMA=<schema in which the Exigen Workflow tables are located> 

Note: The DBS_ORA_SCHEMA parameter is case sensitive and the value must be the same as the database 
user schema name.  

Running Exigen Workflow 

1. To run Exigen Workflow, select Start > Programs > Exigen Solution > Exigen Workflow > 
Workflow Explorer. 

2. Enter the login and password. 

The default login user is DTM, and the password is dtm.  

Modifying Exigen Workflow Components 
To modify or remove installed Exigen Workflow components, proceed as follows: 

1. Insert the Exigen Workflow installation CD into your CD drive. 

2. If the installation does not start automatically, from the Exigen Workflow installation CD, launch the 
Setup.exe file located in the Windows directory. 

The Application Maintenance window appears. 

 
Figure 15: Application Maintenance window 
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3. Select one of the following options as required: 
• To modify installed Exigen Workflow components, select Modify. 
• To remove Exigen Workflow components, select Remove and select one of the following 

options as required: 
• Remove Exigen Solution(s) uninstalls all Exigen Workflow components. 

Warning: If Exigen Installer is not launched from the original Exigen Workflow installation 
location but from another location, this option may cause all installed Exigen solutions to be 
uninstalled.  

• Remove Exigen Installer uninstalls only Exigen Installer. 
4. Click Next. 

If Modify is selected, the Select Installation Type window appears. 

 
Figure 16: Selecting the installation type 

5. Select one of the following installation types as required: 
Installation types 
Type Description 
Typical Installs typical Exigen Workflow components that are required for most users. 

If this installation type is selected and the list of installed and upgraded components 
displayed in the Selected Options window is incorrect, to return to the Select Installation 
Type window, the user can click Back and select Custom. In this case, the list of 
components is preconfigured as in a typical configuration but the user can modify the 
selection as appropriate. 
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Installation types 
Type Description 
Upgrade Performs one of the following actions as selected by the user: 

Action Description 
Reinstall all components Reinstalls all installed Exigen Workflow 

components. 
Upgrade to newer versions only Upgrades those installed Exigen Workflow 

components that have an older version than the 
one available in the installation. 

If this installation type is selected and Exigen Installer displays any component 
discrepancies, to return to the Select Installation Type window, the user can click Back 
and select Custom. In this case, the list of components is preconfigured as in the previous 
installation type, but the user can modify the selection as appropriate. 

Custom Users can specify which Exigen Workflow components must be installed, upgraded, or 
removed. 
If this option is selected initially, there are no components selected to install or upgrade. 
However, if this option is selected after the Typical or Upgrade option is used, the list of 
components to be installed and upgraded is preconfigured according to the previously 
selected installation type. 

6. Click Next. 
7. If Custom is selected, follow instructions as described in Customizing the Exigen Workflow 

Installation. 

Upgrading Exigen Workflow from a Previous Version 
Newer Exigen Workflow versions include new components. To use these components, new 
dependencies are added for components available in previous Exigen Workflow versions. Therefore, if 
a component that requires new components is selected to be upgraded, Exigen Installer reports 
discrepancies between the components. 

To successfully upgrade Exigen Workflow from a previous version, proceed as follows: 

1. From the Exigen Workflow installation CD, launch the Setup.exe file located in the Windows 
directory. 

2. Follow the instructions in the installation wizard until the Select Installation Type window appears. 

3. Depending on the existing configuration, perform one of the following steps: 
• If the typical installation was used in the previous Exigen Workflow version, select Typical. 
• If a customized installation was used in the previous Exigen Workflow version, select Upgrade 

and Reinstall all components. 
4. Click Next and follow the instructions in the installation wizard until one of the following occurs: 

• List of component discrepancies is displayed. 
• The Selected Options window is displayed. 

5. If a list of component discrepancies is displayed, proceed as follows: 
• Record the discrepancies, and click Back until the Select Installation Type window is 

displayed. 
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• Select Custom and click Next. 
A list of Exigen Workflow components is displayed. 

• To resolve the component discrepancies, configure Exigen Workflow components as described 
in Customizing the Exigen Workflow Installation. 

• If any Exigen Workflow Client/Server components are installed, ensure that at least the typical 
selection of the Common Modules component group is selected to be installed. 

• To finish the upgrade process, click Next and follow the instructions in the installation wizard. 
6. In the Selected Options window, carefully review the list of components to be installed and 

upgraded. 

7. If the list of changes in the Selected Options window does not match requirements, follow 
instructions as described in step 5. 

Installing Exigen Workflow in Silent Mode 
Typical Exigen Workflow components can be installed in silent mode without using the graphical user 
interface. This functionality is useful when the same Exigen Workflow components must be installed on 
many user workstations. 

The following topics are described in this section: 

• Silent Installation Parameters 

• Configuring the Custom Configuration File 

• Reconfiguring the Set of Typical Components 

• Identifying Component Dependency 

Silent Installation Parameters 
To install typical Exigen Workflow components in silent mode, on the user's workstation, at the 
command prompt, execute the following command: 

msiexec /i "<full path>\Setup.msi" /q <parameters> 

where <full path> is a full path to the installation directory where the Setup.msi file is located and 
<parameters> is a list of parameters described in the following table: 

Silent installation parameters 
Parameter Description 
FR Full path to the directory containing the Exigen.EWF file. Typically, this is the same 

directory in which the Setup.msi file is located. 
DOC_INST Optional parameter that identifies if the subcomponent documentation must be 

installed. 
The value can be Yes or No. If the parameter is not specified, the default value is 
Yes. 

INI_PATH Optional parameter that identifies a full path to the Setup.ewf file if it differs from 
the location specified in the FR parameter.  
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Silent installation parameters 
Parameter Description 
HISTORY_PATH Full path and file name of the installation log file. 

If the parameter is not specified, the log file is created in the Windows directory with 
the name SETUP_HISTORY.txt. 

REP_PATH Optional parameter that identifies a full path to the repository.rep file if it differs 
from the location specified in the FR parameter. 

CUST_INI_PATH Optional parameter that identifies the location and file name of the custom 
configuration file that contains Exigen Workflow silent installation parameters. 
The configuration file can contain parameters described in this table.  
For information on the custom configuration file, see Configuring the Custom 
Configuration File. 

LOCATION Optional parameter that identifies the directory in which all component installation 
directories are located if it differs from the location specified in the FR parameter. 
By default, it is the same directory in which the Setup.msi file is located. 

Q Optional parameter that specifies silent installation mode. This parameter can have 
one of the following values: 

Value Description 
q Users do not see anything on the screen during installation. 
qb! Users see the progress of the installation for each component. The 

Cancel button is not available. 
This is the default value. 

qb Users see the progress of the installation for each component. The 
Cancel button is available.  

INSTALLDIR Exigen Workflow destination directory. 
The following is the default value: 
C:\VISIFLOW 

INSTALLDIR2 Exigen Workflow Web destination directory. 
The following is the default value: 
C:\VISICOM 

INSTALLDIR3 Exigen Workflow Web Dll destination directory. 
The following is the default value: 
C:\VISICOM\WEB-INF\Dll 

INSTALLDIR4 Exigen programs directory. 
The following is the default value: 
C:\Program Files\Exigen 

LOGINNAME User name required for Application Services and Automatic Queue Server. 
The following is the default value: 
.\visiflow 

PWD Password required for Application Services and Automatic Queue Server. 
The following is the default value: 
exigensrv 
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Silent installation parameters 
Parameter Description 
CONN_STR Default connection string to Exigen Workflow database required for Application 

Services and Automatic Queue Server. 

If any parameters are not specified, their default value is used. 

The following are examples of the command entered to install typical Exigen Workflow components in 
silent mode: 

Example 1 

msiexec /i "E:\Windows\Setup.msi" /q Q=q FR="E:\Windows" 

The preceding command installs all typical Exigen Workflow components in their default directories 
from the specified installation source directory. 

Example 2 

msiexec /i "E:\Windows\Setup.msi" /q Q=q FR="E:\Windows" DOC_INST=No 
INI_PATH="C:\Custom Installation\Setup.ewf" REP_PATH="C:\Custom 
Installation\repository.rep" CUST_INI_PATH="C:\Custom Installation\Setup_PARAM.ini" 

The preceding command installs all typical Exigen Workflow components with the following exceptions: 

• Components are installed in directories specified in the custom configuration Setup_PARAM.ini file. 

• Documentation for subcomponents is not installed. 

• The Setup.ewf file is taken from a specific directory, C:\Custom Installation. 

• The repository.rep file is taken from a specific directory, C:\Custom Installation. 

Configuring the Custom Configuration File 
A custom configuration file can be defined to contain Exigen Workflow silent installation parameters. 
The custom configuration file is useful in cases when the same Exigen Workflow components must be 
installed on many workstations. In this case, one common custom configuration file can be defined to 
ensure that the same installation configuration is used. 

The custom configuration file is a text file in the following format: 

[INSTALL_PARAMETERS] 

<parameter 1> 

<parameter 2> 

... 

Each line in the [INSTALL_PARAMETERS] section is a silent installation parameter. For information on 
silent installation parameters, see Silent Installation Parameters. 
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This file can be specified during the silent installation using the CUST_INI_PATH parameter. 

Reconfiguring the Set of Typical Components 
The silent installation mode installs only typical Exigen Workflow components. The set of typical 
components is defined in the Setup.ewf configuration file, which is delivered together with the 
installation. 

To reconfigure the set of typical components, proceed as follows: 

1. Open the Setup.ewf file. 

2. For the required component, locate the corresponding [s#] section, where # is a number. 

The component to which the section is related is identified in the Caption parameter. 

3. Configure the section as follows: 
• To add the component to the set of typical components, add the Install=Yes line to the 

section. 
• To remove the component from the set of typical components, remove the Install=Yes line 

from the section. 
• To always uninstall any previously installed version of this component before installing the 

current version, add the Remove=Yes line to the section. 

The silent installation does not automatically install those components that are required by the 
typical components. This means that if component A requires component B to be installed, and 
component A is set as a typical component, component B must also be set as a typical component. 
The silent installation cannot be performed if the set of typical components does not also include all 
dependent components. 

4. Ensure that all dependent components are also set as typical. 

For information on how to find a component's dependent components, see Identifying Component 
Dependency. 

5. Save and close the Setup.ewf file. 

Identifying Component Dependency 
This section describes how to identify a component's dependent components, which are required by 
the component. This is important when Exigen Workflow is installed in silent mode. Exigen Workflow 
cannot be installed in silent mode if the set of typical components does not also include all dependent 
components. For information on defining typical Exigen Workflow components, see Reconfiguring the 
Set of Typical Components. 

Procedures described in this section do not provide information about the dependency and compatibility 
of those components that are already installed on the workstation. For example, it is not possible to 
install an older version of a component if a newer version is already installed. In this case, the 
previously installed component must be uninstalled. One way to resolve this problem is to add the 
Remove=Yes parameter in the Setup.ewf file for the component as described in Reconfiguring the Set 
of Typical Components. 
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The following topics are described in this section: 

• Identifying Component Dependency Using the repository.rep File 

• Identifying Component Dependency Using the Main Exigen Workflow Installation 

Identifying Component Dependency Using the repository.rep File 

Component dependency is defined in the repository.rep file, which is usually located in the same 
directory where the Setup.exe file is located. 

Warning: The repository.rep file must not be modified. It can only be viewed to determine 
dependency of Exigen Workflow components. 

To determine a component's dependent components, the administrator must identify the following 
information about the component: 

• component identifier used in the installation configuration files 

• component version number delivered in the installation package 

The following procedure describes how to identify this information and determine a component's 
dependent components: 

1. To locate the component identifier, in any plain text editor, open the Setup.ewf file and locate the 
section [sX] that contains the following line: 

Caption=<component name> 

where X is the component identifier. 

For example, the following section means that the identifier for Clear Cache Utility is 12. 

[S12] 

Caption=Clear Cache Utility  

2. Close the Setup.ewf file. 

3. To identify the component version number, go to the directory where the component's installation 
.msi file is located. 

4. In the component's installation directory, using any plain text editor, open the component's .ver file. 

In the .ver file, the component version number is specified by the Version parameter as follows: 

Version=<version number>.<build number> 

The version number is three numbers separated by a period. The build number is not important to 
identify a component's dependencies. 

In the following example, the component version number is 5.6.12000: 

Version=5.6.12000.137 

5. Close the component's .ver file. 
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6. Using any plain text editor, open the repository.rep file. 

7. In the repository.rep file, locate the following section: 

[s<component's identifier>V<component's version>] 

For example, if the component identifier is 12 and its version is 5.6.12000, the required section in 
the repository.rep file is the following: 

[s12V5.6.12000] 

This section defines other components that are required by this component to work. 

If there is no such section in the repository.rep file, the component does not have any 
dependencies and there are no restrictions on installing this component in silent mode. 

8. To identify the dependent components, examine the section. 

The following two parameters in this section identify this component's dependant components: 

Parameters for identifying a component's dependency 
Parameter Description 
RequiredX Identifies a required component as follows: 

RequiredX=<identifier of the required component used in the 
Setup.ewf file> 

RX_V1=<minimal required version> 

RX_V2=<maximal required version> 
where X is a sequence number that is used to list multiple required components. All listed 
dependent components are mandatory for this component to work. 
The RX_V1 parameter is the minimal required version of the dependent component. It 
means that the dependent component must not be older than the specified version. 
The RX_V2 parameter is the maximal allowed version of the dependent component. It 
means that the dependent component must not be later than the specified version. 
The RX_V2 parameter can be blank. In this case, there is no limitation on the maximal 
dependent component version. 
In the following example, component S20 requires components S19 and S50 to be 
installed: 
 
[S20V5.6.10000] 

Required1=S19 

R1_V1=5.5.11000 

R1_V2=5.6.12000 

 

Required2=S50 

R2_V1=5.5.11000 

R2_V2= 
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Parameters for identifying a component's dependency 
Parameter Description 
DeputyX_Y Parameter similar to the RequiredX parameter that specifies a set of alternative 

components rather than one required component. At least one of the listed alternative 
components must be installed, but not necessarily all. 
The DeputyX_Y parameter is as follows: 
DeputyX_1=<identifier of the first alternative component> 

DX_1_V1=<minimal required version> 

DX_1_V2=<maximal required version> 
 
DeputyX_2=<identifier of the second alternative component> 

DX_2_V1=<minimal required version> 

DX_2_V2=<maximal required version> 

 

... 
 
X is a sequence number that lists multiple sets of alternative dependent components. The 
component requires at least one dependent component from each alternative component 
set. 
Y is a sequence number that lists multiple alternative components within a component set. 
In the following example, the component S50 requires either component S106 or 
component S51: 
 
[S50v5.6.12000] 

Deputy1_1=S106 

D1_1_V1=5.6.10000 

D1_1_V2= 

 

Deputy1_2=S51 

D1_2_V1=5.6.10000 

D1_2_V2= 

9. Close the repository.rep file. 

10. To perform the silent installation successfully, ensure that all identified dependant components are 
also set as typical components as described in Reconfiguring the Set of Typical Components. 

11. Repeat this procedure again for each identified dependant component to identify its dependent 
components. 

Identifying Component Dependency Using the Main Exigen Workflow Installation 

To verify the validity of a configured set of typical components using the main Exigen Workflow 
installation, proceed as follows: 

1. On a workstation that does not have any Exigen Workflow components installed, run the main 
Exigen Workflow installation. 
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2. Select the typical installation type. 

3. Click Next until a dependency problem window appears listing all other components that must also 
be installed for the selected components to work. 

4. Reconfigure the set of typical components so that the listed dependent components are also set as 
typical as described in Reconfiguring the Set of Typical Components. 

5. Repeat this procedure until no dependency problems are displayed. 
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Chapter 3: Setting Up the Database 
Connection 
This section describes how to set up the connection to the database server for Exigen Workflow. 

The following topics are described in this section: 

• Database Connection Overview 

• SQL.INI File Structure 

• Connecting to SQL Server Using ODBC 

• Connecting to SQL Server Using OLE DB 

• Connecting to DB2 UDB Using ODBC 

• Connecting to DB2 UDB Using OLE DB 

• Connecting to DB2 UDB Using IBM iSeries Access for Windows 

• Connecting to Oracle 

• Configuring the Database Connection Using Connect DB Wizard 

Database Connection Overview 
To run Exigen Workflow, the target database server must be running and the appropriate database 
client must be installed and configured. 

Before connecting to the database, make sure that the following prerequisites are met: 

• All required client software is installed on the client workstation, including the database 
communication software. 

• The database server and drivers are running. 

• The name of the database used by Exigen Workflow does not exceed 8 characters. 

Exigen Workflow uses a common initialization file named SQL.INI to store the database client 
connection settings. The SQL.INI file is located in the VISIFLOW\SYSTEM directory.  

SQL.INI File Structure 
The SQL.INI file is a simple text file that contains database connection configuration parameters. 
Applications find database connection settings by looking through the file for the section identifiers that 
apply. Each section has a brief description after the section identifier. 

Note: In the SQL.INI file, the semicolon is used to indicate a comment line. 
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To configure the client parameters in the SQL.INI file, proceed as follows: 

6. In the [win32client.dll] section, specify the communication DLLs that the Windows applications 
intend to use. To access more than one database, specify or uncomment the comdll entries for all 
the databases as described in the following table: 

Servers and parameters 
Server name Parameter 

Oracle comdll=sqlora32 

SQL Server comdll=sqlodb32 

DB2 UDB comdll=sqlodb32 

7. For SQL Server or DB2 UDB server, select the following section: 

[odbcrtr] 

remotedbname=<Exigen Workflow database alias>,dsn=<ODBC data source name> 

buffrow=0 

odbctrace=off 

odbctracefile=sql.log 

8. If creating a connection to a new Exigen Workflow system, select a name for the Exigen Workflow 
database.  

If you are connecting to the Exigen Workflow system and it is already running, you must ask your 
system administrator for the appropriate Exigen Workflow database name. 

9. If you are going to connect to multiple databases through ODBC, in the [odbcrtr] section 
create a separate remotedbname=<Exigen Workflow DB alias>,dsn=<ODBC data source 
name> statement for each database. 

10. For Oracle server, edit the following section: 

[oragtwy] 

remotedbname=<Exigen Workflow DB alias>,@<Oracle database service name> 

longbuffer=32767 

substitute=", 

substitute=SYSSQL., 

fetchrow=20 

11. For Oracle server, delete any quotation marks appearing in the substitute line.  

12. After modifying the SQL.INI file, delete the GUPTA.INI file if it is present in the same directory. 

The GUPTA.INI file is created automatically by Centura if the ODBC router is loaded, and contains 
information about previously configured database connections. If the GUPTA.INI file is present, 
Centura runtime may use the parameters specified in this file instead of SQL.INI. 
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Normally Centura Routers scan the remotedbname records of the SQL.INI file to connect to the 
database with the requested Centura database name. When the requested remotedbname value is 
located, the information specified after the comma is used to connect to the database. 

In cases where Centura ODBC Router is loaded, Centura scans for the DSN value matching the 
requested Centura database name first and uses this parameter for the connection. Only if a matching 
DSN value is not found does Centura scan for the requested remotedbname value. 

If Centura ODBC Router is commented in the winclient.dll section of the SQL.INI file, it is not 
loaded.  

Connecting to SQL Server Using ODBC  
To connect to the SQL Server database using ODBC, proceed as follows: 

1. To set up the ODBC Connection in Windows 2000, select Start > Settings > Control Panel > 
Administrative Tools > Data Sources (ODBC). 

2. In the ODBC Data Source Administrator window, select the System DSN tab.  

3. Click Add.  
4. In the Create New Data Source window, select SQL Server and click Finish.  
5. In the Create a New Data Source to SQL Server window, set the Name to your database name 

and Server to your database server name, and click Next.  
6. In the Create a New Data Source to SQL Server window, select the authentication method and 

enter a user name and password. 

7.  Click Next.  
8. Check Change Default Database to and select your database name. 

9. Click Next.  
10. Click Finish.  
11. To confirm that your connection is correct, click Test Data Source. 
12. Modify the SQL.INI file as follows: 

[win32client] 
clientname=Win32Client 
 
[win32client.comments] 
 
[win32client.dll] 
comdll=sqlodb32 
[odbcrtr] 
remotedbname=<Exigen Workflow DB name>,dsn=<ODBC data source name> 
buffrow=0 
odbctrace=off 
odbctracefile=sql.log 

The [odbcrtr] section specifies parameters for the ODBC Router. 
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13. Enter your database alias used by the Exigen Workflow system and the ODBC reference name. 

Only letters and digits are permitted in the remotedbname name. 

Connecting to SQL Server Using OLE DB 
This section describes how to set up an OLE DB connection to the SQL Server. This functionality is 
supported by the following components: 

• Retention Server 

• Configuration Browser 

• Audit Viewer 

To set up a connection to the SQL Server database using the OLE DB connection, proceed as follows: 

1. Open the SQL.INI file. 

2. If the SQL.INI file does not contain a section named [OLEDB], create the [OLEDB] section. 

The [OLEDB] section must be located before the [odbcrtr] section. 

3. In the [OLEDB] section, add the following parameters: 

remotedbname=<Exigen Workflow database name>, Provider=SQLOLEDB;Initial 
Catalog=<default database name>;Data Source=<SQL Server address or name> 

4. Save and close the SQL.INI file. 

Connecting to DB2 UDB Using ODBC 
This section describes how to set up an ODBC connection to the DB2 UDB database server. 

Warning: Exigen Workflow requires the Read Committed transaction isolation level when using the 
DB2 UDB database. 

To connect to DB2 UDB, proceed as follows: 

1. Select Start > Settings > Control Panel > Administrative Tools > Data Sources (ODBC). 
2. Select the appropriate driver and follow the instructions in the window.  

3. In the SQL.INI file, find the corresponding [odbcrtr] section and make the necessary 
corrections. 

4. To configure your data source, proceed as follows:  
1. In the ODBC Data Source Administrator window, select the System DSN tab. 
2. Select the data source, and click Configure. 

The DB2 Message dialog appears. 

3. Click No. 
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The CLI/ODBC Settings dialog appears.  

4. Click Advanced. 

The Advanced CLI/ODBC Settings dialog appears.  

5. Select the Service tab. 
6. In the Parameter pane, select Known workarounds PATCH1. 
7. In the Value pane, select MS Visual Basic fix for empty searched update/delete. 
8. In the Parameter pane, select Warnings. 
9. In the Value pane, select the Ignore warnings check box. 
10. To accept these settings, click OK. 

5. To save the configuration, click OK. 
6. Open the VISI.INI file. 

7. In the VISI.INI file, add the following section: 

[DB2_OS] 
<data source>=<operating system> 

• <data source> is the name of the DB2 database. It must be identical to the value specified in 
the DBS_MASTER parameter in the same VISI.INI file. 

• <operating system> is one of the following values representing the operating system on the 
database server: 
Operating system values 
Value Operating system 
4 AS400 

A AIX 

O OS390 

X Other 

If the operating system is not specified, the system assumes that the value is X. 

8. Save and close the VISI.INI file. 

Connecting to DB2 UDB Using OLE DB 
This section describes how to set up an OLE DB connection to the DB2 UDB. This functionality is 
supported by the following components: 

• Retention Server 

• Configuration Browser 

To set up a connection to the DB2 UDB database using the OLE DB connection, proceed as follows: 

1. Open the SQL.INI file. 

2. If the SQL.INI file does not contain a section named [OLEDB], create the [OLEDB] section. 
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The [OLEDB] section must be located before the [odbcrtr] section. 

3. In the [OLEDB] section, add the following parameters: 

remotedbname=<Exigen Workflow database name>, Provider=IBMDA400;Data Source=<DB2 
server address> 

4. Save and close the SQL.INI file. 

5. Open the VISI.INI file. 

6. In the VISI.INI file, add the following section: 

[DB2_OS] 
<data source>=<operating system> 

• <data source> is the name of the DB2 database. It must be identical to the value specified in 
the DBS_MASTER parameter in the same VISI.INI file. 

• <operating system> is one of the following values representing the operating system on the 
database server: 
Operating system values 
Value Operating system 
4 AS400 

A AIX 

O OS390 

X Other 

If the operating system is not specified, the system assumes that the value is X. 

7. Save and close the VISI.INI file. 

Connecting to DB2 UDB Using IBM iSeries Access for 
Windows 
The connection to the database is performed through the ODBC Data Source Administrator. 

Warning: Exigen Workflow requires the Read Committed transaction isolation level when using the 
DB2 UDB database. 

To connect to DB2 UDB using IBM iSeries Access for Windows, proceed as follows: 

1. Select the appropriate driver and follow the instructions in the window.  

2. In the SQL.INI file, find the corresponding [odbcrtr] section and make the necessary 
corrections. 

3. In the ODBC Data Source Administrator window, select the System DSN tab. 

4. Select the data source and click Configure. 

The iSeries Access for Windows ODBC Setup window appears. 



Installation Guide Chapter 3: Setting Up the Database Connection 

Copyright © 1994-2005, Exigen Properties, Inc. and/or affiliates.  All rights reserved. 
Exigen Workflow 5.6 Page 43 of 128 

5. Select the Translation tab. 

6. Click Advanced. 

The Advanced translation options window appears. 

7. In the SQL statement CCSID list box, select Unicode (UCS-2) CCSID. 
8. To accept the settings, click OK. 
9. To save the configuration, click OK. 
10. Open the VISI.INI file. 

11. In the VISI.INI file, add the following section: 

[DB2_OS] 
<data source>=<operating system> 

• <data source> is the name of the DB2 database. It must be identical to the value specified in 
the DBS_MASTER parameter in the same VISI.INI file. 

• <operating system> is one of the following values representing the operating system on the 
database server: 
Operating system values 
Value Operating system 
4 AS400 

A AIX 

O OS390 

X Other 

If the operating system is not specified, the system assumes that the value is X. 

12. Save and close the VISI.INI file. 

Connecting to Oracle 
This section describes how to set up a connection to the Oracle database server. 

The following topics are described in this section: 

• Installing Oracle Client 

• Setting Up a Connection for the Main Exigen Workflow Components 

• Setting Up a Connection Using the ODBC or OLE DB Driver 

Installing Oracle Client 
Oracle Client must be installed on the user’s workstation before connecting to the Oracle database. 

To install Oracle Client, proceed as follows: 

1. From the Oracle installation source, launch the Oracle Client setup application. 
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2. Select to install either the ODBC driver or the OLE DB driver as required. 

3. After a successful Oracle Client installation, modify the registry information by adding the following 
string variables in HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE: 
String variables in registry 
Name Value 
Name oraoci 

Data oraclientX.dll 

where X is the Oracle Client version. 

Setting Up a Connection for the Main Exigen Workflow 
Components 
Most Exigen Workflow components use the native Oracle driver to connect to the Oracle server. For 
information on components that do not support this type of connection, see Setting Up a Connection 
Using the ODBC or OLE DB Driver. 

To set up a connection using the native Oracle driver, proceed as follows: 

1. Open the SQL.INI file. 

2. In the [win32client.dll] section uncomment the following line: 

comdll=sqlora32 

3. In the [oragtwy] section, add or edit the following line as required: 

remotedbname=<Exigen Workflow database name>,@<Oracle database service name> 

4. Save and close the SQL.INI file. 

Setting Up a Connection Using the ODBC or OLE DB Driver 
The following Exigen Workflow components do not support the database connection using the native 
Oracle driver: 

• Retention Server 

• Configuration Browser 

• Audit Viewer 

• Component Configuration Manager 

• ADSync 

To use the preceding components, one of the following additional connection types must be configured 
in addition to the standard connection configuration: 

• Setting Up an ODBC Connection 

• Setting Up an OLE DB Connection 
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Setting Up an ODBC Connection 

To set up an ODBC connection, proceed as follows: 

1. Open the SQL.INI file. 

2. In the [win32client.dll] section, uncomment the following line: 

comdll = sqlodb32 

This line must be located after the following line: 

comdll = sqlora32 

3. Save and close the SQL.INI file. 

4. To finish the configuration, perform one of the following procedures depending on the connection 
type: 
• Setting Up the Oracle ODBC Driver with the DSN Alias 
• Setting Up the Oracle ODBC Driver without the DSN Alias 
• Setting Up the Microsoft ODBC Driver with the DSN Alias 
• Setting Up the Microsoft ODBC Driver without the DSN Alias 

Setting Up the Oracle ODBC Driver with the DSN Alias 

To set up the Oracle ODBC driver with the DSN alias, proceed as follows: 

1. Select Start > Settings > Control Panel > Administrative Tools > Data Sources (ODBC). 
2. Select the System DSN tab. 

3. Click Add. 
4. In the driver list, select the Oracle ODBC driver. 

5. Click Finish. 

The setup window appears. 

6. Specify the following parameters as required: 
• DSN, which must be different from the Exigen Workflow database name 
• Oracle database service name 
• user ID 
• description if required 

7. Click OK. 
8. Open the SQL.INI file. 

9. If the SQL.INI file does not contain a section named [odbcrtr], create the [odbcrtr] section. 

10. In the [odbcrtr] section, add the following parameters: 

remotedbname=<Exigen Workflow database name>,dsn=<ODBC data source name> 

11. Save and close the SQL.INI file. 
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Setting Up the Oracle ODBC Driver without the DSN Alias 

To set up the Oracle ODBC driver without the DSN alias, proceed as follows: 

1. Open the SQL.INI file. 

2. If the SQL.INI file does not contain a section named [odbcrtr], create the [odbcrtr] section. 

3. In the [odbcrtr] section, add the following parameters: 

remotedbname=<Exigen Workflow database name>,driver={<Oracle ODBC driver 
name>};dbq=<Oracle database service name> 

4. Save and close the SQL.INI file. 

Setting Up the Microsoft ODBC Driver with the DSN Alias 

To set up the Microsoft ODBC driver with the DSN alias, proceed as follows: 

1. Select Start > Settings > Control Panel > Administrative Tools > Data Sources (ODBC). 
2. Select the System DSN tab. 

3. Click Add. 
4. In the list, select Microsoft ODBC for Oracle. 
5. Click Finish. 

The setup window appears. 

6. Specify the following parameters as required: 
• DSN, which must be different from the Exigen Workflow database name 
• description if required 
• user name 
• Oracle database service name 

7. Click OK. 

8. Open the SQL.INI file. 

9. If the SQL.INI file does not contain a section named [odbcrtr], create the [odbcrtr] section. 

10. In the [odbcrtr] section, add the following parameters: 

remotedbname=<Exigen Workflow database name>,dsn=<data source name> 

11. Save and close the SQL.INI file. 

Setting Up the Microsoft ODBC Driver without the DSN Alias 

To set up the Microsoft ODBC driver without the DSN alias, proceed as follows: 

1. Open the SQL.INI file. 

2. If the SQL.INI file does not contain a section named [odbcrtr], create the [odbcrtr] section. 

3. In the [odbcrtr] section, add the following parameters: 

remotedbname=<Exigen Workflow database name>,driver={Microsoft ODBC for 
Oracle};server=<Oracle database service name> 
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4. Save and close the SQL.INI file. 

Setting Up an OLE DB Connection 

To set up an OLE DB connection, proceed as follows: 

1. Open the SQL.INI file. 

2. If the SQL.INI file does not contain a section named [oledb], create the [oledb] section. 

The [oledb] section must be located before the [odbcrtr] section. 

3. In the [oledb] section, add the following parameters: 

remotedbname=<Exigen Workflow database name>, Provider=OraOLEDB.Oracle; Data 
Source=<Oracle database service name> 

4. Save and close the SQL.INI file.  

Configuring the Database Connection Using Connect DB 
Wizard 
Exigen Workflow includes a tool named Connect DB Wizard for configuring the SQL.INI file by using a 
graphical user interface. However, Connect DB Wizard does not allow administrators to configure some 
specific configuration settings. 

To configure the database connection using Connect DB Wizard, proceed as follows: 

1. Select Start > Programs > Exigen Solution > Exigen Workflow > Connect DB Wizard. 

The Centura Connectivity Administrator window appears. 
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Figure 17: Connect DB Wizard 

All data source items configured on the workstation are listed in a tree structure divided into related 
groups. 

2. To examine the configured data source items, expand the tree structure as required. 

3. To add a new database connection item, select the related data source group and click Add. 

The Data Source Configuration window appears. 
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Figure 18: Adding a new data source 

The window may differ depending on the selected data source type. 

4. In the Data Source Name field, enter the database alias. 

5. In the Connection String field, enter the data source name. 

For information on the data source definition syntax in each specific case, click Help. 

6. To add the new data source item, click OK. 
7. To remove a configured data source item, select the item and click Remove. 
8. To modify a configured data source item, select the item and click Properties. 
9. To disable a configured data source item, select the item and click Disable. 
10. To enable a disabled data source item, select the item and click Enable. 
11. To apply changes made to the data source items, click OK. 
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Chapter 4: Installing Exigen Workflow Web 
This section describes how to install Exigen Workflow Web. The following topics are described in this 
section: 

• What is Exigen Workflow Web? 

• Exigen Workflow Web System Requirements 

• Installing the Exigen Workflow Web Server 

• General Steps for Configuring the Application Server 

• Configuring Application Servers 

• Using the Exigen Workflow Web Configuration Page 

• Using the Proxy Server 

• Running Exigen Workflow Web 

What is Exigen Workflow Web? 
Exigen Workflow Web is an application that provides web access to the basic workflow objects and 
administration tools. Once the Exigen Workflow Web server is installed and configured properly, clients 
can perform most of their daily duties through the Internet. 

Exigen Workflow Web has a different interface and it does not support all functions available in the 
main Exigen Workflow system. 

Exigen Workflow Web System Requirements 
For information on Exigen Workflow Web hardware and software requirements, see the Exigen 
Workflow readme file. 

Installing the Exigen Workflow Web Server 
To install the Exigen Workflow Web server, proceed as follows: 

1. Insert the Exigen Workflow installation CD into the CD drive. 

2. If the installation does not start automatically, from the CD, launch the Setup.exe file. 

3. Follow the installation instructions until you reach the Exigen Workflow window as described in 
General Installation Steps. 

4. In the Exigen Workflow window, in the Install/Upgrade column, select the Web Components 
check box. 
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Figure 19: Installing Exigen Workflow Web 

5. To select which Exigen Workflow Web components to install or upgrade, click Details and configure 
the components as required. 

6. To install Exigen Workflow Web documentation, select the Install documentation for 
subcomponents check box. 

7. Click Next. 

The Destination Folder window appears. 



Installation Guide Chapter 4: Installing Exigen Workflow Web 

Copyright © 1994-2005, Exigen Properties, Inc. and/or affiliates.  All rights reserved. 
Exigen Workflow 5.6 Page 52 of 128 

 
Figure 20: Specifying Exigen Workflow Web installation directories 

8. To set the directory in which to install the main Exigen Workflow Web files, in the Exigen Workflow 
Web Root Folder box, click Browse and select the required directory. 

9. To set the directory in which to install Exigen Workflow Web DLL libraries, in the Exigen Workflow 
Web Dll Folder box, click Browse and select the required directory. 

10. Click Next. 
11. To complete the installation process, follow the instructions as described in General Installation 

Steps. 

Warning: To avoid the user credentials being sent through the network as a plain text, it is 
recommended to use Secure Socket Layer (SSL) in Exigen Workflow Web. 
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General Steps for Configuring the Application Server 
Exigen Workflow Web is run as a web application on an application server. The application server and 
Exigen Workflow Web server environment must be configured for users to be able to access Exigen 
Workflow Web. 

The following procedure describes general steps for configuring the application server and Exigen 
Workflow Web server environment: 

1. Before installing the application server, install JDK. 

2. Ensure that the web.xml file located in the VISICOM\WEB-INF directory is in the correct format for 
the application server. 

3. If it is not in the correct format, rewrite all settings of this file in the correct format for your application 
server as described in your application server’s documentation. 

4. Ensure the application server can find the document root location by specifying the document root 
for Exigen Workflow Web as described in the application server’s documentation. 

5. Ensure the application server can find Exigen Workflow Web Java classes and libraries. 

For most application servers, this can be achieved by specifying Java libraries and class files 
location as the WEB-INF directory inside the document root directory. 

6. If it still does not work with your application server, specify the CLASSPATH variable for it as 
described in the application server’s documentation. 

7. Ensure the application server can find the native libraries location by modifying the PATH 
environment variable of your application server to point to the Exigen Workflow Web native libraries 
directory as described in the application server's documentation. 

The PATH environment variable must be modified before starting the application server. 

8. Ensure that the application server can find your database driver by adding the location of your 
database driver to the application server’s CLASSPATH variable.  

For more information on configuring database drivers and application servers, see your application 
server and database driver documentation. 

9. To improve the performance of Exigen Workflow Web, configure the initial and maximal memory 
heap size used for the Java virtual machine according to the system load and available memory. 

For information on configuring specific application servers, see Configuring Application Servers. 

The Exigen Security Services package that supports NT LAN Manager (NTLM) authentication for 
Exigen Workflow Web is not included in the Exigen Workflow installation package. For information 
on the Exigen Security Services package that supports NTLM, contact Exigen Support Services. 

Configuring Application Servers 
This section describes how to install Exigen Workflow Web as a default application for a given 
application server with minimal changes to the default server’s settings. 
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The following topics are described in this section: 

• Tomcat 4.1.27 Standard Edition Application Server 

• Tomcat 5.5.6 Standard Edition Application Server 

• WebLogic 8.1 Application Server 

• WebSphere 5.1 Application Server 

• WebSphere 6.0 Application Server 

Tomcat 4.1.27 Standard Edition Application Server 
This section describes how to install Exigen Workflow Web as a default application for the Tomcat 
4.1.27 Standard Edition Application Server. 

The following topics are described in this section: 

• Configuring Tomcat 4.1.27 as a Standalone Java Process 

• Configuring Tomcat 4.1.27 as a Service 

Configuring Tomcat 4.1.27 as a Standalone Java Process 

To configure Tomcat 4.1.27 as a standalone Java process, proceed as follows: 

1. From the Exigen Workflow installation CD, launch the Setup.exe file. 

2. Install the Exigen Workflow Web server as described in Installing the Exigen Workflow Web Server. 

3. Ensure the following location is selected as the Exigen Workflow Web root directory: 

<Tomcat installation directory>\webapps\visicom 

The location for native libraries is updated as follows: 

<Tomcat installation directory>\webapps\visicom\WEB-INF\Dll 

4. Perform one of the following steps: 
• Copy your database driver to the VISICOM\WEB-INF\lib directory. 
• Specify the location of your database driver in the application server’s CLASSPATH variable. 

5. To specify the native libraries path for Tomcat, go to Tomcat’s bin directory and open the 
startup.bat file.  

6. Modify the doneSetArgs label as follows: 

:doneSetArgs 

SETLOCAL 

set path=%CATALINA_HOME%\webapps\visicom\WEB-INF\Dll;%path% 

call "%EXECUTABLE%" start %CMD_LINE_ARGS% 

ENDLOCAL 
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:end 

7. To improve the performance of Exigen Workflow Web, add the following line before the application 
server startup command: 

set JAVA_OPTS=-Xms<initial heap size> –Xmx<maximal heap size> 

This command sets the initial and the maximal memory heap size used for the Java virtual 
machine. 

For example, if 512 MB of memory is available, it is recommended to add the following line to the 
startup.bat file: 

set JAVA_OPTS=-Xms128m –Xmx328m 

However, these parameters must be configured according to the system load and available 
memory. 

8. Save and close the file. 

9. Start Tomcat. 

10. Open the Web browser and in the address bar, enter the following: 

http://localhost:8080/visicom 

The Exigen Workflow Web login page appears. 

Configuring Tomcat 4.1.27 as a Service 

The following procedure describes how to configure Tomcat 4.1.27 as a service. 

Prerequisite: The NT Service component must be selected in the Tomcat setup during the Tomcat 
4.1.27 installation. 

1. From the Exigen Workflow installation CD, launch the Setup.exe file. 

2. Install the Exigen Workflow Web server as described in Installing the Exigen Workflow Web Server. 

3. Ensure the following location is selected as the Exigen Workflow Web root directory: 

<Tomcat installation directory>\webapps\visicom 

The location for native libraries is updated as follows: 

<Tomcat installation directory>\webapps\visicom\WEB-INF\Dll 

4. Perform one of the following steps: 
• Copy your database driver to the VISICOM\WEB-INF\lib directory. 
• Specify the location of your database driver in the application server’s CLASSPATH variable. 

5. Add the location of Exigen Workflow Web native libraries to the system PATH variable. 

Exigen Workflow Web native libraries are located in the VISICOM\WEB-INF\Dll directory. 

6. In the service console, start Tomcat as a service named Apache Tomcat 4.1. 
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7. Open the Web browser and in the address bar, enter the following: 

http://localhost:8080/visicom 

The Exigen Workflow Web login page appears. 

Tomcat 5.5.6 Standard Edition Application Server 
This section describes how to install Exigen Workflow Web as a default application for the Tomcat 5.5.6 
Standard Edition Application Server. 

Prerequisite: To run Tomcat 5.5.6 using JDK 1.4.2, the Tomcat compatibility package must be 
installed. It can be retrieved from the following website: 

http://jakarta.apache.org/tomcat/ 

The following topics are described in this section: 

• Configuring Tomcat 5.5.6 as a Standalone Java Process 

• Configuring Tomcat 5.5.6 as a Service 

Configuring Tomcat 5.5.6 as a Standalone Java Process 

To configure Tomcat 5.5.6 as a standalone Java process, proceed as follows: 

1. From the Exigen Workflow installation CD, launch the Setup.exe file. 

2. Install the Exigen Workflow Web server as described in Installing the Exigen Workflow Web Server. 

3. Ensure the following location is selected as the Exigen Workflow Web root directory: 

<Tomcat installation directory>\webapps\visicom 

The location for native libraries is updated as follows: 

<Tomcat installation directory>\webapps\visicom\WEB-INF\Dll 

4. Perform one of the following steps: 
• Copy your database driver to the visicom\WEB-INF\lib directory. 
• Specify the location of your database driver in the application server’s CLASSPATH variable. 

5. Add the location of Exigen Workflow Web native libraries to the system PATH variable. 

Exigen Workflow Web native libraries are located in the visicom\WEB-INF\Dll directory. 

6. To configure Tomcat, go to Tomcat’s bin directory and launch the tomcatw executable.  

7. To improve the performance of Exigen Workflow Web, in the Java tab, modify the following memory 
parameters as required: 
• Initial memory pool 

• Maximum memory pool 

These parameters set the initial and the maximum memory heap size used for the Java virtual 
machine. 

http://jakarta.apache.org/tomcat/
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For example, if 512 MB of memory is available, it is recommended to set the memory parameters 
as follows: 

Java virtual machine memory parameter values 
Parameter Value 
Initial memory pool 128 MB 
Maximum memory pool 328 MB 

8. Click OK. 
9. Start the Tomcat application server. 

10. Open the Web browser and, in the address bar, enter the following address: 

http://localhost:8080/visicom 

The Exigen Workflow Web login page appears. 

Configuring Tomcat 5.5.6 as a Service 

The following procedure describes how to configure Tomcat 5.5.6 as a service. 

Prerequisite: The NT Service component must be selected in the Tomcat setup during the Tomcat 
5.5.6 installation. 

1. From the Exigen Workflow installation CD, launch the Setup.exe file. 

2. Install the Exigen Workflow Web server as described in Installing the Exigen Workflow Web Server. 

3. Ensure the following location is selected as the Exigen Workflow Web root directory: 

<Tomcat installation directory>\webapps\visicom 

The location for native libraries is updated as follows: 

<Tomcat installation directory>\webapps\visicom\WEB-INF\Dll 

4. Perform one of the following steps: 
• Copy your database driver to the visicom\WEB-INF\lib directory. 
• Specify the location of your database driver in the application server’s CLASSPATH variable. 

5. Add the location of Exigen Workflow Web native libraries to the system PATH variable. 

Exigen Workflow Web native libraries are located in the visicom\WEB-INF\Dll directory. 

6. To start the Tomcat service, perform one of the following steps: 
• In the Windows Services console, start the Apache Tomcat service. 
• In the Tomcat configuration manager, in the General tab, start the Apache Tomcat service. 

7. Open the Web browser and, in the address bar, enter the following address: 

http://localhost:8080/visicom 

The Exigen Workflow Web login page appears. 
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WebLogic 8.1 Application Server 
This section describes how to configure WebLogic 8.1 application server to run Exigen Workflow Web. 

The following topics are described in this section: 

• Prerequisites 

• Configuring WebLogic 8.1 Application Server 

Prerequisites 

The following requirements must be met before configuring the WebLogic 8.1 application server: 

• WebLogic 8.1 must be installed. 

• Exigen Workflow Web must be installed. 

• The path to the Exigen Workflow Web DLL directory must be defined in the system PATH variable. 

Configuring WebLogic 8.1 Application Server 

To configure the WebLogic 8.1 application server, proceed as follows: 

1. Run BEA WebLogic Configuration Wizard. 

The Create or Extend a Configuration window appears. 
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Figure 21: WebLogic Configuration Wizard 

2. Select Create a new WebLogic configuration and click Next. 

The Select a Configuration Template window appears. 
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Figure 22: Selecting a configuration template 

3. In the tree, expand the BEA folder and select Basic WebLogic Server Domain. 
4. Click Next. 

The Choose Express or Custom Configuration window appears. 
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Figure 23: Selecting a configuration type 

5. Select Express and click Next. 

The Configure Administrative Username and Password window appears. 
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Figure 24: Configuring the administrative account 

6. Enter values in the following fields as required: 
Administrative account fields 
Field Description 
User Name Administrator user name. 
User Password Administrator password. 
Confirm User Password Confirmation of administrator 

password. 
Description Administrative account description. 

7. Click Next. 

The Configure Server Start Mode and Java SDK window appears. 
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Figure 25: Configuring the server start mode and Java SDK 

8. Select the required configuration startup mode and click Next. 
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Figure 26: Creating the WebLogic configuration 

9. In the tree, select your server and configure the server name, listen address, and port as required. 

10. Click Create. 

The configuration creation process starts. 

11. When the configuration is created, click Done. 

12. Open the config.xml file located in the created domain directory. 

13. In the <Domain> section, add the following record: 

<Application  

Name="VISICOM"  

Path="D:\"  

StagingMode="nostage"  

TwoPhase="true"> 

<WebAppComponent  
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Name="VISICOM"  

PreferWebInfClasses="true" 

Targets="myserver" URI="VISICOM"/> 

</Application> 

14. Configure the Path, Name, and URI parameters as appropriate for your production environment. 

15. Save and close the config.xml file. 

16. To start the server, in the domain directory, perform one of the following tasks as required: 
• To start the server as a service, run the installService.cmd file. 
• To start the server manually, run the startWebLogic.cmd file. 

17. Enter the administrator user name and password. 

18. To test the configuration, in your Web browser address bar, enter the following address: 

http://localhost:7001/VISICOM 

If the server is configured correctly, the Exigen Workflow Web login window appears. 

WebSphere 5.1 Application Server 
This section describes how to configure the WebSphere 5.1 application server to run Exigen Workflow 
Web. 

The following topics are described in this section: 

• Prerequisites 

• Setting Up the Application Server 

Prerequisites 

The following steps must be performed before configuring the application server: 

• The WebSphere 5.1 application server must be installed. 

• The Exigen Workflow Web for WebSphere component must be installed. 

The Exigen Workflow Web for WebSphere component is delivered as the 
WorkflowWEBWebsphere.msi installation package. It contains the visicom.ear file, which is used 
in the application server configuration. 

Setting Up the Application Server 

To configure the WebSphere application server to run Exigen Workflow Web, proceed as follows: 

1. Start the WebSphere application server. 

2. Open the WebSphere Administrative Console. 

3. Enter the login name and click OK. 
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4. In the navigation tree, select Applications > Install New Application. 
5. Select Local file system and, in the Specify path field, enter the path to the visicom.ear file. 

 
Figure 27: Selecting the visicom.ear file 

6. Click Next twice. 

7. In the Application Name field, enter visicom. 

 
Figure 28: Changing the application name 

8. Click Next three times. 

9. Click Finish. 
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WebSphere installs the application. 

10. When the application is installed successfully, click Save to Master Configuration. 
11. In the Save to Master Configuration window, click Save. 

 
Figure 29: Saving changes to the master configuration 

Do not click any buttons until the application is fully saved. The application is completely saved 
when the window contents are updated. 

12. In the navigation tree, select Applications > Enterprise Applications. 
13. In the Enterprise Applications window, click visicom. 

 
Figure 30: Viewing enterprise applications 
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14. In the Additional Properties list, click Session management. 

 
Figure 31: Configuring the application 

15. Make the following changes to the configuration: 
• Select the Override check box. 
• Clear the Enable Cookies check box. 
• Select the Enable URL Rewriting check box. 

 
Figure 32: Configuring session settings 

16. Click OK. 
17. When the page is reloaded, click Save. 
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18. In the Save to Master Configuration window, click Save. 

Do not click any buttons until the application is fully saved. The application is completely saved 
when the window contents are updated. 

19. In the Enterprise Applications window, click visicom. 
20. Select the Local Topology tab and click visicom.war. 

 
Figure 33: Selecting the visicom.war web module 

21. In the Classloader mode list box, select PARENT_LAST. 

 
Figure 34: Selecting the class loader mode 



Installation Guide Chapter 4: Installing Exigen Workflow Web 

Copyright © 1994-2005, Exigen Properties, Inc. and/or affiliates.  All rights reserved. 
Exigen Workflow 5.6 Page 70 of 128 

22. Click OK. 
23. Click Save twice. 

24. Stop the WebSphere application server. 

25. To register the document.dll file, at the command prompt, enter and execute the following 
command: 

regsvr32 "WebSphere\AppServer\installedApps\<your server 
name>\visicom.ear\visicom.war\WEB-INF\Dll\document.dll" 

If it is required that the document.dll file must be upgraded, it must first be unregistered using the 
regsvr32 command. After the upgrade, the file must be registered again. 

26. To register the dtmstg.dll file, at the command prompt, execute the following command: 

regsvr32 "WebSphere\AppServer\installedApps\<your server 
name>\visicom.ear\visicom.war\WEB-INF\Dll\dtmstg.dll" 

If it is required that the dtmstg.dll file must be upgraded, it must first be unregistered using the 
regsvr32 command. After the upgrade, the file must be registered again. 

27. Ensure that all DLL files required by Exigen Workflow Web are specified in the PATH environment 
variable. 

28. Ensure that the visicom.properties file is located in the following directory: 

WebSphere\AppServer\installedApps\<your server 
name>\visicom.ear\visicom.war\WEB-INF\Config 

29. Delete the commons-logging.jar file from the following directory: 

WebSphere\AppServer\installedApps\<your server 
name>\visicom.ear\visicom.war\WEB-INF\lib 

30. Start the WebSphere application server. 

31. To test Exigen Workflow Web, in the web browser’s address bar, enter the following address: 

http://localhost:9080/visicom 

If everything is configured correctly, the Exigen Workflow Web login page appears. 

WebSphere 6.0 Application Server 
This section describes how to configure the WebSphere 6.0 application server to run Exigen Workflow 
Web. 

The following topics are described in this section: 

• Prerequisites 

• Setting Up the Application Server 
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Prerequisites 

The following steps must be performed before configuring the application server: 

• The WebSphere 6.0 application server must be installed. 

• The Exigen Workflow Web for WebSphere component must be installed. 

The Exigen Workflow Web for WebSphere component is delivered as the 
WorkflowWEBWebsphere.msi installation package. It contains the visicom.ear file, which is used 
in the application server configuration. 

Setting Up the Application Server 

To configure the WebSphere application server to run Exigen Workflow Web, proceed as follows: 

1. Start the WebSphere application server. 

2. Open the WebSphere Administrative Console. 

3. Enter the login name and click OK. 
4. In the navigation tree, select Applications > Install New Application. 
5. Select Local file system and, in the Specify path field, enter the path to the visicom.ear file. 

 
Figure 35: Selecting the visicom.ear file 

6. Click Next twice. 

7. In the Application name field, enter visicom. 
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Figure 36: Changing the application name 

8. Click Next three times. 

9. Click Finish. 

WebSphere installs the application. 

10. When the application is installed successfully, click Save to Master Configuration. 
11. In the Save window, click Save. 
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Figure 37: Saving changes to the master configuration 

Do not click any buttons until the application is fully saved. The application is completely saved 
when the window contents are updated. 

12. In the navigation tree, select Applications > Enterprise Applications. 
13. In the Enterprise Applications window, click visicom. 

 
Figure 38: Viewing enterprise applications 

14. In the Additional Properties list, click Session management. 
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Figure 39: Configuring the application 

15. Make the following changes to the configuration: 
• Select the Override session management check box. 
• Clear the Enable cookies check box. 
• Select the Enable URL rewriting check box. 
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Figure 40: Configuring session settings 

16. Click OK. 
17. When the page is reloaded, click Save. 
18. In the Enterprise Applications window, click Save. 

Do not click any buttons until the application is fully saved. The application is completely saved 
when the window contents are updated. 

19. In the Enterprise Applications window, click visicom. 
20. Select the Local Topology tab and click visicom.war. 
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Figure 41: Selecting the visicom.war web module 

21. In the Class loader mode list box, select PARENT_LAST. 

 
Figure 42: Selecting the class loader mode 

22. Click OK. 
23. Click Save twice. 

24. Stop the WebSphere application server. 

25. To register the document.dll file, at the command prompt, enter and execute the following 
command: 

regsvr32 "WebSphere\AppServer\installedApps\<your server 
name>\visicom.ear\visicom.war\WEB-INF\Dll\document.dll" 
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If it is required that the document.dll file must be upgraded, it must first be unregistered using the 
regsvr32 command. After the upgrade, the file must be registered again. 

26. To register the dtmstg.dll file, at the command prompt, execute the following command: 

regsvr32 "WebSphere\AppServer\installedApps\<your server 
name>\visicom.ear\visicom.war\WEB-INF\Dll\dtmstg.dll" 

If it is required that the dtmstg.dll file must be upgraded, it must first be unregistered using the 
regsvr32 command. After the upgrade, the file must be registered again. 

27. Ensure that all DLL files required by Exigen Workflow Web are specified in the PATH environment 
variable. 

28. Ensure that the visicom.properties file is located in the following directory: 

WebSphere\AppServer\profiles\default\installedApps\<your server 
name>\visicom.ear\visicom.war\WEB-INF\Config 

29. Delete the commons-logging.jar file from the following directory: 

WebSphere\AppServer\profiles\default\installedApps\<your server 
name>\visicom.ear\visicom.war\WEB-INF\lib 

30. Start the WebSphere application server. 

31. To test Exigen Workflow Web, in the web browser’s address bar, enter the following address: 

http://localhost:9080/visicom 

If everything is configured correctly, the Exigen Workflow Web login page appears. 

Using the Exigen Workflow Web Configuration Page 
The main Exigen Workflow Web server configuration parameters are stored in the 
visicom.properties file located in the VISICOM\WEB-INF\Config directory. Parameters in this file 
are configured using the Exigen Workflow Web configuration page. 

This section describes only the basic steps for configuring Exigen Workflow Web using the Exigen 
Workflow Web configuration page. For full information on using the Exigen Workflow Web configuration 
page, see Exigen Workflow Web Administrator’s Guide, Chapter 9: Configuring an Exigen Workflow 
Web Session. 

To configure Exigen Workflow Web, proceed as follows: 

1. Start the application server. 

2. Open your web browser and enter the following address in the address bar: 

http://<host name>:<port number>/VISICOM/Config/VisiConfig.jsp 

The Exigen Workflow Web configuration page appears. 

3. In the list, select the database or define a new one. 
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4. Specify the JDBC connection URL. 

The URL depends on the JDBC driver selected. You must follow the URL specification rules 
described in your JDBC driver documentation. 

5. Specify the JDBC driver.  

The JDBC driver depends on the selected database brand. For information on the selected DB 
Brand, see the database and application server documentation. 

6. Specify the user name and password for the master database. 

7. If necessary, specify the required Exigen Workflow Web settings as described in Exigen Workflow 
Web Administrator’s Guide, Chapter 9: Configuring an Exigen Workflow Web Session. 

8. Click Apply Settings. 
9. Restart the application server. 

10. Test the master database connection. 

It is recommended to restrict access to the Exigen Workflow Web configuration page either by IP 
address or by using another method. For information on restricting access to Exigen Workflow Web 
configuration page, see your application server documentation. 

Note: Not all Exigen Workflow Web settings are available in the configuration page. Several parameters can 
be modified only by editing the visicom.properties file manually. For information about the 
visicom.properties file, see Exigen Workflow Web Administrator’s Guide, Chapter 9: Configuring 
an Exigen Workflow Web Session. 

Using the Proxy Server 
If the business environment uses a proxy server to access Exigen Workflow Web, add the following 
parameters in the visicom.properties file located in the VISICOM\WEB-INF\Config directory: 

Proxy server parameters in the visicom.properties file 
Parameter Description 
VISICOM_EXTERNAL_HOST Proxy server name. 

VISICOM_EXTERNAL_PATH Path of the proxy server. 

VISICOM_EXTERNAL_PORT Proxy server port. 

VISICOM_EXTERNAL_PROTOCOL Protocol used to access the proxy server. 

The following example shows how to implement these parameters in the visicom.properties file: 

#Workflow working with proxy  

VISICOM_EXTERNAL_HOST=proxy 

VISICOM_EXTERNAL_PATH=path1 

VISICOM_EXTERNAL_PORT=443 
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VISICOM_EXTERNAL_PROTOCOL=https 

Running Exigen Workflow Web 
To run Exigen Workflow Web, proceed as follows: 

1. Start the application server. 

2. Open the web browser and enter the corresponding URL in the address bar: 

http://<host name>:<port number>/VISICOM/VisiLogin.jsp 

The Exigen Workflow Web login page appears. 

 
Figure 43: Exigen Workflow Web login page 
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Chapter 5: Integrating Exigen Workflow with 
Other Exigen Products 
This section describes the following topics: 

• Integrating Exigen Workflow with Exigen E-Forms 

• Integrating Exigen Workflow with Exigen E-Mail 

Integrating Exigen Workflow with Exigen E-Forms 
Exigen Workflow enables integration with Exigen E-Forms. The integration allows viewing, creating, 
and editing electronic forms from within Exigen Workflow.  

Note: You must have administrator rights to perform this operation. 

To integrate Exigen Workflow with Exigen E-Forms, proceed as follows: 

1. Make sure that the JDBC settings of your database are correct.  

This applies only to Exigen Workflow Web. JDBC settings can be modified in the Exigen Workflow 
Web configuration page. For information on configuring Exigen Workflow Web, see Using the 
Exigen Workflow Web Configuration Page. 

2. In Exigen Workflow, in Database Tools, start Project Builder. 
3. In the menu of the project in which you want to use Exigen E-Forms, select Project > Create E-

Forms Tables. 
4. To perform actions with Exigen E-Forms from within Exigen Workflow, in the Workflow Builder, 

create a queue node for a workflow in which you want to use Exigen E-Forms.  

5. In the E-Forms tab, specify the actions to be performed with the forms. 
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Figure 44: Modify Node window: E-Form tab 

6. To add a new action, click Add new Action. 

The Action window appears. 
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Figure 45: Action window 

7. In the Action list box, select an action. 

8. Enter the form name and interface name. 

9. Enter a description if appropriate. 

The description is optional.  

10. Click OK.  
11. To modify existing actions, click Modify Action.  
12. To delete an action, click Delete Action. 
13. To specify the path to Exigen E-Forms server in Exigen Workflow, start Project Builder. 

14. For the project in which to use Exigen E-Forms, select Project > Project Configuration.  

The Project Configuration page appears. 

15. Select the E-Forms tab. 
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Figure 46: Project Configuration page: E-Forms tab 

16. In the E-Forms target field, enter the path to your Exigen E-Forms server. 

17. Click Apply. 

New Exigen E-Forms buttons are now available, when you select a queue from a workflow of the 
configured project depending on the selected Exigen E-Forms actions. 

The following figure shows an Exigen Workflow Web node with a New Form button. 
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Figure 47: New Form button 

Integrating Exigen Workflow with Exigen E-Mail 
This section describes how to integrate Exigen Workflow with Exigen E-Mail. 

The Exigen Workflow integration with Exigen E-Mail enables users to send Exigen E-Mail documents to 
Exigen Workflow and import them as documents in parcels. After a successful integration, Exigen E-
Mail documents can be accessed and viewed in Exigen Workflow in the following workflow nodes: 

• Queue 

• Retrieve 

• Inspect 

• Work Item Submitter 

• Low Volume Scan 

• High Volume Scan 

• High Volume Index 

To integrate Exigen E-Mail with Exigen Workflow, proceed as follows: 

1. In the Exigen Workflow project that uses Exigen E-Mail documents, in the DOCUMENT table, 
create a custom integer field called A_EMAIL_ID. 

For information on creating custom table fields, see Exigen Workflow Administrator’s Guide, Part I. 

2. In Workflow Explorer, open the Administrator utility. 

3. Select Administrator > Exigen E-Mail Settings. 

The Exigen E-Mail Settings window appears. 
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Figure 48: Enabling Exigen E-Mail in Exigen Workflow Client/Server 

4. Select the Use E-Mail check box. 

5. In the URL to E-Mail server field, enter the address to your Exigen E-Mail server, which contains 
the following parameters: 

• protocol 
• host name 
• port 
• path to the Exigen E-Mail server 

The following is an example of the Exigen E-Mail server URL: 

http://email_host:8081/emailrouter 

6. Click OK. 
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Chapter 6: Installing Remote Storage Server 
This section describes how to install and configure Remote Storage Server. 

The following topics are described in this section: 

• Remote Storage Server Overview 

• Installing Remote Storage Server on the Server 

• Installing Remote Storage Server on the Client 

Remote Storage Server Overview 
Remote Storage Server is an application that provides access to Exigen Workflow documents on a 
remote location. It also complements the security model within the Exigen Workflow environment. 

Remote Storage Server provides restricted access to document files. When Remote Storage Server is 
configured, the clients can access document files only through the Exigen Workflow system and not 
through file sharing. 

Remote Storage Server can be started either in console mode or in service mode. Console mode is 
used for troubleshooting or in special configuration environments. Generally, in a production 
environment, Remote Storage Server must be configured to run as a Windows service. 

For optimal performance, it is recommended to install Remote Storage Server on the same workstation 
where the file server is stored. 

Remote Storage Server uses the standard Remote Procedure Call (RPC) mechanism for network 
communications. For information on RPC, see the following web pages: 

• http://www.microsoft.com/technet/prodtechnol/windowsserver2003/library/TechRef/4dbc4c95-935b-
4617-b4f8-20fc947c7288.mspx 

• http://support.microsoft.com/default.aspx?scid=kb;en-us;154596 

The main service that Remote Storage Server uses is the RPC Endpoint Mapper. This service uses the 
following ports: 

• TCP 135 

• UDP 135 

Installing Remote Storage Server on the Server 
This section describes how to install and configure Remote Storage Server on the file server. 

Prerequisite: The Remote Storage Server component must be installed from the Exigen Workflow 
installation CD. 

http://www.microsoft.com/technet/prodtechnol/windowsserver2003/library/TechRef/4dbc4c95-935b-4617-b4f8-20fc947c7288.mspx
http://www.microsoft.com/technet/prodtechnol/windowsserver2003/library/TechRef/4dbc4c95-935b-4617-b4f8-20fc947c7288.mspx
http://support.microsoft.com/default.aspx?scid=kb;en-us;154596
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After installing Remote Storage Server, the following files are located in the VISIFLOW\RSS\Server 
directory: 

• rss.exe 

• rssmsg.dll 

To install Remote Storage Server, proceed as follows: 

1. To configure Remote Storage Server registry entries, launch the Registry editor.  

2. Open the following registry section: 

HKEY_LOCAL_MACHINE/SOFTWARE/Exigen/RSS/CurrentVersion/RSS Server 

 
Figure 49: Remote Storage Server registry settings 

The Bindings section contains communication protocols. The TCP/IP protocol is added to the 
Bindings section during installation. 

3. To use a different protocol, in the Bindings section, add a corresponding protocol key. 

The following table lists supported protocols: 
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Supported protocols 
Protocol Protocol key 
TCP/IP based protocol ncacn_ip_tcp 

HTTP based protocol ncacn_http 

Named Pipes based 
protocol 

ncacn_np 

SPX based protocol ncacn_spx 

Local RPC based 
protocol 

ncalrpc 

4. To configure Remote Storage Server, modify the following registry entries as required: 
Remote Storage Server registry entries 
Registry entry Description 
Min calls Minimum calls according to the number of users. The default value is 0000000.

Max calls Maximum number of open threads. 

Audit Log Directory Directory in which the log is created. 

An example of an audit log directory is c:\\rss\\logs. 

This entry is optional. 

Logging Level Logging level. 

Possible values for this parameter are from 0 to 4 as follows: 
• Value 0 produces no logging.  
• Value 4 enables complete logging.  
• Value 1 is recommended for production because it logs only critical errors. 

5. If Remote Storage Server is run as a service, to configure the Remote Storage Server logon 
account, proceed as follows: 
• Select Start > Settings > Control Panel > Administrative Tools > Services. 
• Right-click Exigen Remote Storage Server and select Properties. 
• Select the Log On tab. 
• Select This account. 
• Specify the account that has access to the remote file system. 
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Figure 50: Configuring the Remote Storage Server logon account 

6. Launch Remote Storage Server using one of the following methods:   
• To start Remote Storage Server as a service, perform one of the following actions: 

• Select Start > Settings > Control Panel > Administrative Tools > Services and start 
Exigen Remote Storage Server. 
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Figure 51: Launching Remote Storage Server as a service 

• At the command prompt, execute the following command:  
net start rsserver  

• To start Remote Storage Server in a console mode, launch the rss.exe file located in the 
VISIFLOW\RSS\Server directory. 

Installing Remote Storage Server on the Client 
This section describes how to install Remote Storage Server on the client. A workstation can be a 
server and a client simultaneously. 

Prerequisite: The Remote Storage Server component must be installed from the Exigen Workflow 
installation CD. 

To install Remote Storage Server on the client, proceed as follows: 

1. To configure the Remote Storage Server client for Exigen Workflow Client/Server, locate the 
VISIFLOW\INI directory and copy the rsc.ini and remote.ini files to the VISIFLOW\SYSTEM 
directory. 

2. To configure the Remote Storage Server client for Exigen Workflow Web, perform the following 
actions depending on the document access mode: 
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• If remote access mode is used, on the Exigen Workflow Web server, locate the VISIFLOW\INI 
directory and copy the rsc.ini and remote.ini files to the VISICOM\WEB-INF\Dll directory. 

• If the local access mode is used, on the Exigen Workflow Web client workstation, locate the 
VISIFLOW\INI directory and copy the rsc.ini and remote.ini files to the directory where 
Web DMS Viewer is installed. 

3. Open the rsc.ini file for editing. 

4. In the rsc.ini file, add or modify a configuration section that defines the Remote Storage Server 
location and communication protocol. 

This configuration section is referenced by the remote.ini file to automatically substitute the actual 
location on the server for the document location defined in the database. 

The following table describes parameters in the rsc.ini file: 

rsc.ini file parameters 
Parameter Description 
Network Address Server name where Remote Storage Server is running. This name must be entered 

according to the specifications of the communication protocol that is used.  

Protocol 
Sequence 

Communication protocol used by Remote Storage Server. 

For information on protocol syntax, see Installing Remote Storage Server on the 
Server. 

Domain Domain in which Remote Storage Server is running. This parameter is required only 
if the server and the client are in different domains. 

Authentication 
Level 

Authentication level used for the remote procedure call. This parameter is optional 
and can have values from 0 to 5. The default value is 0. 

For more information on authentication levels, see 
http://msdn.microsoft.com/library/default.asp?url=/library/en-
us/rpc/rpc/authentication_level_constants.asp. 

If the client is working on Windows NT 4 with a Windows 2000 domain server, the 
authentication level must be set to 1. 

There can be several configuration sections in the rsc.ini file, but each section must have a 
unique name. 

The following is an example of a configuration section: 

[SERVER1_TCPIP] 

Network Address=fileserver.domain.com 

Protocol Sequence=ncacn_ip_tcp 

Domain=DOMAIN2 

Authentication Level=1 

5. Save and close the rsc.ini file. 

6. Open the remote.ini file for editing. 

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/rpc/rpc/authentication_level_constants.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/rpc/rpc/authentication_level_constants.asp
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Exigen Workflow uses information in the remote.ini configuration file to communicate with 
Remote Storage Server. Within the system, the actual location on the server is automatically 
substituted for a document location defined in the database. 

The following types of document location substitution are supported by Remote Storage Server: 

Document location substitution types supported by Remote Storage Server 
Type Description 
Drive substitution Substitutes the actual document location on the server for a logical drive in the 

database. 

For example, if in the project configuration, the document location is defined to be 
on drive E and the remote.ini file associates drive E with a remote file server, 
instead of accessing documents on drive E, the system accesses documents on 
the specified remote file server. From the system's point of view, documents are 
still stored on drive E. 

This substitution type is defined in the [Drives] section as follows: 

<drive to be replaced>:=<section in the rsc.ini 
file>,<timeout in milliseconds> 

The associated configuration section in the rsc.ini file defines the configuration 
for the actual location on the server. 

Network location 
substitution 

Similar to the drive substitution type, but instead of substituting a logical drive, it 
substitutes a network location specified according to UNC. 

This substitution type is defined in the [UNCs] section as follows: 

<location to be replaced>=<section in the rsc.ini 
file>,<timeout in milliseconds> 

The associated configuration section in the rsc.ini file defines the configuration 
for the actual location on the server. 

The [UNCs] section must contain only the computer name and share name. 
Share subdirectories cannot be used. 

Path substitution Replaces one document location path with another. 

This is particularly useful when the document location is changed but the 
information in the database remains the same. 

This substitution type is defined in the [Substitute] section as follows: 

<previous location>=<new location> 

There can be more than one entry in each section, and all lines starting with ? are ignored. 

The following is an example of remote.ini file contents: 

[Drives] 

E:=SERVER1_TCPIP,9000 

[UNCs] 

\\FILESERVER1\SHARE1\=SERVER1_TCPIP,9000 
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[Substitute] 

\\FILESERVER5\DOCS\=\\FILESERVER3\NEW\ 

7. Save and close the remote.ini file. 
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Chapter 7: Setting Up Exigen Workflow with 
Terminal Server and Citrix MetaFrame 
This section describes how to configure Terminal Server and the Citrix MetaFrame server to provide an 
Exigen Workflow application environment. 

Although some Exigen Workflow customers use Citrix MetaFrame, formal quality assurance of such 
configurations is not in the scope of quality assurance plans for Exigen Workflow. Experience shows 
that problems can arise when a solution or individual solution components depend on the use of local 
directories or locally stored configuration files. Such problems are usually solved in the scope of 
individual customer solutions by creating redirect scripts in Citrix MetaFrame, and they must not affect 
the core product. However, since it is not possible to predict all possible variations of customer-specific 
solutions, Citrix MetaFrame support requirements must be examined on a case-by-case basis within 
the scope of specific solution requirements. 

Warning: Exigen Workflow server components cannot be used in the Terminal Server and Citrix 
MetaFrame environment. 

To configure Terminal Server and Citrix MetaFrame, proceed as follows: 

1. Install Citrix on Terminal Server. 

2. Create users as described in the Microsoft support documentation for Terminal Server. 

3. Ensure that the user profile directory and home directory are not the same.  

For information on user profiles and home directories, see Microsoft support documentation. 

4. Go to the Active Directory Users and Computers window. 

5. Select a user.  

6. To open the Citrix Track Properties window, right-click the user. 

7. Ensure that all Terminal Server user workstations have a common network drive, for example, Q. 

8. Send each user a request to send you their visiclt.ini file from their local Windows directory. 

9. Request that each user logs into Terminal Server via Citrix MetaFrame or straight into Terminal 
Server using the remote login. 

10. Do not run Exigen Workflow, but perform a remote login and logout. 

11. Verify that the user Windows directory is created for the user. 

Note: Do not create this directory using scripts unless you know how to change user permissions with scripts, 
because valid user permissions for each directory must be created. 

12. From each user's local Windows directory, copy the visiclt.ini file into the appropriate home 
Windows directory.  

Note: The appearance of the window in Exigen Workflow, such as window size and location, can differ.  

For example, for a user named john2, user profiles are stored in the following directory: 
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\\server\citrix\profile\john2 

The following is the home directory: 

\\server\citrix\home\john2 

This directory can also be added to user search paths and used for all other programs that require 
individual user settings. 
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Chapter 8: Installing Application Services 
This section describes how to install and configure Application Services. 

The following topics are described in this section: 

• Application Services Overview 

• Installing Application Services from the Main Exigen Workflow Installation 

• Installing Application Services from a Standalone Installation 

• Installing Application Services in Silent Mode 

• Reinstalling Application Services in Silent Mode 

• Uninstalling Application Services in Silent Mode 

• Changing the Application Services User Account 

• Configuring Application Services 

Application Services Overview 
Application Services is a middleware application with a COM interface that provides access to the 
Exigen Workflow data store and aggregates functionality related to the Exigen Workflow resources. 

Application Services is required by Automatic Queue Server. 

Before using Application Services, you must configure the database client to support Transaction 
Server as described in Chapter 10: Configuring the Database Client to Support Transaction Server. 

Installing Application Services from the Main Exigen 
Workflow Installation 
To install Application Services from the main Exigen Workflow installation, proceed as follows: 

1. Insert the Exigen Workflow installation CD into the CD drive. 

2. If the installation does not start automatically, from the CD, launch the Setup.exe file. 

3. Follow the installation instructions until you reach the Exigen Workflow window as described in 
General Installation Steps. 

4. In the Install/Upgrade column, in the Automated Services row, click Details. 
5. In the Automated Services window, in the Install/Upgrade column, select the Workflow 

Application Services check box. 
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Figure 52: Installing Application Services 

6. Click OK. 
7. Click Next. 

The Account information window appears. 
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Figure 53: Account information window 

The Account information window is used to define the following: 

• user account required by the Application Services COM+ application 
• default connection string for the Exigen Workflow project database 
• predefined configuration of registry settings for the database client to support Distributed 

Transaction Coordinator (MSDTC) 

In most cases, the user account is a local user account on the workstation where Application 
Services is run. 

8. In the Account information window, enter the user name and password to be used by Application 
Services as follows: 
• For domain users, specify the user name as follows: 

<domain>\<user> 

• For local users, specify only the user name. 

If the account fields are left blank, the system creates a default user with user name visiflow and 
password exigensrv. 

If the specified local user does not exist, the installation creates the user. The following rights are 
granted automatically to local and domain users: 

• log on as service 
• log on as batch job 
• default COM security access permission 
• default COM security access permission for interactive user 
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The Connection string field specifies the default connection string for the Exigen Workflow project 
database, and can be left blank. 

For information on the connection string syntax and examples, see Application Services Connection 
String Examples. 

9. To set up the required registry entries for the database client to support MSDTC, select the brand of 
your database client. 

The database brand can be selected only if Application Services is not currently installed on the 
workstation. If there is a previous version of Application Services installed on the workstation, the 
list of database brands is in read-only mode and cannot be modified. 

To change the selected database brand, the previous version of Application Services must be 
removed. 

If None is selected, no registry entries are modified and the user must configure them manually if 
required. 

10. Click Next. 
11. To complete the installation process, follow the instructions as described in Finishing the 

Installation. 

12. If you did not define a default connection string, in the Application Services Console, add 
connection strings for the projects and workflows to be used by Application Services after 
installation. 

For more information on the Application Services Console, see Configuring Application Services. 

Installing Application Services from a Standalone 
Installation 
If you have a standalone Application Services MSI installation, you can install it separately from Exigen 
Workflow. 

To install Application Services using a standalone installation, proceed as follows: 

1. Run the AppServer.msi file. 

The Exigen Application Services Setup window appears. 

2. Click Next. 

The User information window appears. 

3. Specify the personalization information as required. 

4. Click Next.  

The Destination Folder window appears. 



Installation Guide  Chapter 8: Installing Application Services 

Copyright © 1994-2005, Exigen Properties, Inc. and/or affiliates. All rights reserved.   
Exigen Workflow 5.6 Page 100 of 128 

 
Figure 54: Selecting the destination directory 

5. In the Destination Folder window, click Browse and select the location where to install Application 
Services. 

6. Click Next. 

The Installation parameters window appears. 
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Figure 55: Specifying account information 

7. In the Installation parameters window, enter the account name and password under which the 
service and COM+ application is running. 

The default account user name is visiflow and password is exigensrv. 

8. To set up the required registry entries for the database client to support MSDTC, select the brand of 
your database client. 

The database brand can be selected only if Application Services is not currently installed on the 
workstation. If there is a previous version of Application Services installed on the workstation, the 
list of database brands is in read-only mode and cannot be modified. 

To change the selected database brand, the previous version of Application Services must be 
removed. 

If None is selected, no registry entries are modified and the user must configure them manually if 
required. 

9. Click Next. 
10. To complete the installation, follow the instructions that appear on the screen. 

Installing Application Services in Silent Mode 
To install Application Services in silent mode, at the command prompt, execute the following command: 
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msiexec /i "<installation file location>\AppServer.msi" LEGACPROJ="<connection 
string>" SERVICE_ACCOUNT_NAME="<login name>" SERVICE_ACCOUNT_PASSWORD="<password>" 
INSTALLDIR="<full path 1>" INSTALLDIR3="<full path 2>" /q 

If the INSTALLDIR parameter is specified, all Application Services files are installed in the <full path 
1>\AppServer directory: 

If the INSTALLDIR3 parameter is specified, all Application Services files are installed in the <full 
path 2> directory. 

Reinstalling Application Services in Silent Mode 
To reinstall Application Services in silent mode, at the command prompt, execute the following 
command: 

msiexec /fvomus "<installation file location>\AppServer.msi" LEGACPROJ="<connection 
string>" SERVICE_ACCOUNT_NAME="<login name>" SERVICE_ACCOUNT_PASSWORD="<password>" 
REINSTALL=ALL  /q 

Uninstalling Application Services in Silent Mode 
To uninstall Application Services in silent mode, at the command prompt, execute one of the following 
commands: 

• msiexec /x {E95C0646-040A-48CC-918B-D5C435CD8A7A} /q 

• msiexec /x "<installation file location>\AppServer.msi" /q 

Changing the Application Services User Account 
To change the user name for Application Services after the installation, proceed as follows: 

1. To change the user account for the Application Services COM+ application, open the Component 
Services console by selecting Start > Settings > Control Panel > Administrative Tools > 
Component Services. 

2. In the tree on the left side of console, select Component Services > Computers > My Computer 
> COM+ Applications. 

3. Right-click the EWF Engine COM+ application and select the Properties submenu. 

4. In the EWF Engine Properties dialog, select the Identity tab. 

5. Select the This User radio button and specify new user credentials. 

6. To save the changes, click OK. 
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Configuring Application Services 
This section describes how to configure Application Services. All configuration steps describes in this 
section are performed using Application Services Console. 

To launch Application Services Console, select Start > Programs > Exigen Solution > Exigen 
Workflow > Application Services Console. 

 
Figure 56: Application Services Console 

The following topics are described in this section: 

• Defining Connection Strings 

• Setting Up the Event Trace Service 

• Defining Trace Masks 

• Configuring Application Services Options 

Defining Connection Strings 
If a default connection to the Exigen Workflow database is not defined for Application Services, a 
separate connection string must be defined for each project and workflow to be accessed from 
Application Services. 

Note: If all projects and workflows can be accessed via one connection string, it is advisable to set this 
connection string as the default. 
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If the audit project is located in a database that is different from the one specified in the default project 
connection string, a separate connection string must be set up for the audit project. 

The following topics are described in this section: 

Defining Project Connection Strings 

To define project connection strings, proceed as follows: 

1. In Application Services Console, in the left pane, select Console Root > Application Services 
Console > Connection Information > Project. 

All project connection strings defined for Application Services are displayed in the right pane. 

 
Figure 57: List of project connection strings 

2. To create a new project connection string, in the right pane, right click the blank space and select 
New > Project Connection. 

The Create New Project Connection window appears. 
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Figure 58: Defining a new project connection string 

3. In the Project ID field, enter the project ID for which the connection string must be defined. 

4. In the Connection String field, enter the connection string. 

The following table provides examples of Application Services connection strings: 

Application Services connection string examples 
Type Example 
OLE DB provider for 
Oracle 

Provider=MSDAORA;Password=user_password; User 
ID=user_name;Data Source=ora_service; 

ODBC data source DSN=dsn_name;UID=user_name;pwd=user_password; 

OLE DB provider for 
SQL Server 

Provider=SQLOLEDB;Data Source=server_name; 

Initial Catalog=database_name; 

User ID= user_name;Password= user_password; 

It is possible to override the default services provided by the OLE DB provider for ODBC by 
specifying the following settings in the connection string: 

Connection string default service override parameters 
Value in the connection string Services enabled 
OLE DB Services = -1; All services. This is the default value. 
OLE DB Services = -4; All services except pooling and automatic transaction enlistment. 
OLE DB Services = -5; All services except Client Cursor Engine. 
OLE DB Services = -8; All services except pooling, automatic transaction enlistment, and 

Client Cursor Engine. 
OLE DB Services = -3; Only pooling and automatic transaction enlistment services with a 

session level aggregation. 
OLE DB Services = 0; None. 

The following is a sample connection string with the OLE DB Services parameter: 

DSN=dsn_name;UID=user_name;pwd=user_password;OLE DB Services = -4; 

5. Click OK. 

The new connection string appears in Application Services Console. 

6. To modify a connection string, in the right pane, right click a project connection string and select 
Properties. 
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The Project Connection Properties window appears. 

7. Make the required changes and click OK. 
8. To delete a connection string, in the right pane, right click a project connection string and select 

Delete. 

Defining Workflow Connection Strings 

To define workflow connection strings, proceed as follows: 

1. In Application Services Console, in the left pane, select Console Root > Application Services 
Console > Connection Information > Workflow. 

All workflow connection strings defined for Application Services are displayed in the right pane. 

 
Figure 59: List of project connection strings 

2. To create a new workflow connection string, in the right pane, right click the blank space and select 
New > Workflow Connection. 

The Create New Workflow Connection window appears. 
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Figure 60: Defining a new workflow connection string 

3. In the Workflow ID field, enter the workflow ID for which the connection string must be defined. 

4. In the Connection String field, enter the connection string. 

5. Click OK. 

The new connection string appears in Application Services Console. 

6. To modify a connection string, in the right pane, right click a workflow connection string and select 
Properties. 

The Workflow Connection Properties window appears. 

7. Make the required changes and click OK. 
8. To delete a connection string, in the right pane, right click a workflow connection string and select 

Delete. 

Setting Up the Event Trace Service 
Application Services generates various event messages during run-time. Administrators can view these 
event messages to monitor and debug Application Services applications. To record and view 
Application Services event trace messages, the Event Trace Service must be set up. 

The Event Trace Service is a Windows service that writes Application Services event messages in text 
files according to defined trace parameters. 

Note: It is also possible to use an application named DebugView for viewing Application Services event 
messages. However, DebugView is not recommended when Application Services is running in a 
production environment. 

To set up the Event Trace Service, proceed as follows: 

1. In Application Services Console, in the left pane, right click Application Services Console and 
select Configure Event Trace Service. 

If the Event Trace Service is not installed, a message window appears. 
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Figure 61: Event Trace Service message 

2. To install the Event Trace Service, click Yes. 

The Event Trace Service is installed and a confirmation message appears. 

 
Figure 62: Confirmation message 

3. To close the confirmation message window, click OK. 

The Exigen Workflow Event Trace Service Settings window appears. 

 
Figure 63: Configuring the Event Trace Service 

The Event Trace Service writes event messages in log files that have the following name: 

EWFTrace_<date>_<time>.trc 

4. To automatically delete old log files, proceed as follows: 
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• Select the Delete log files older than check box. 
• In the field, enter the number of hours after which log files must be deleted. 

5. To automatically split log files that reach a specific size, proceed as follows: 
• Select the Split trace files if longer than check box. 
• In the field, enter the maximum size in megabytes. 

6. To write only those event messages that are recorded in Exigen Workflow, select the Capture 
workflow messages only check box. 

7. To define the location where log files must be saved, in the Save captured messages to folder 
field, specify the location. 

8. To start the Event Trace Service automatically when the operating system is loaded, select the 
Automatically start Trace Service when operating system is loaded check box. 

9. To apply changes, click OK. 
10. To filter event messages that are produced by Application Services, define trace masks as 

described in Defining Trace Masks. 

Defining Trace Masks 
A trace mask is a filter that defines which event messages produced by Application Services must be 
captured and recorded in Event Trace Service log files. 

To define trace masks, proceed as follows: 

1. In Application Services Console, in the left pane, select Console Root > Application Services 
Console > Trace Masks. 

All trace masks defined in Application Services are displayed in the right pane. 
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Figure 64: List of trace masks 

2. To create a new trace mask, in the right pane, right click the blank space and select New > Trace 
Mask. 

The New Trace Mask window appears. 

 
Figure 65: Creating a new trace mask 

3. To define the source from which event messages must be recorded, in the Trace Mask String field, 
enter the trace source string. 

The following table describes available trace sources: 

Available trace sources 
String Trace source 
CacheOA Cache access, commit, get, and put messages from the cacao.dll library. 

CacheAccessor Accessor interface from the Accessor.dll library. 
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Available trace sources 
String Trace source 
CacheBinder Supervisor service from the Binder.exe application. 
StoreLI Index store from the StoreLI.dll library. 

StoreLW Workflow store from the StoreLW.dll library. 

ObjectPad Object pad from the vfobjpad.dll library. 
CognomenObj Public Cognomen.dll interface. 

CognomenMoniker Internal Cognomen calls. 
QueueServer Automatic Queue Server messages. 
QS.Handler.* Messages of the productized Automatic Queue Server handlers. 
QS.Filter.* Messages of the productized Automatic Queue Server handler filters. 

The * symbol can be used as a substitute for any text string to define a trace mask that filters 
messages from a group of sources. For example, the Cache* string filters messages from the 
CacheOA, CacheAccessor, and CacheBinder sources. 

4. To define the minimal priority of messages that must be recorded, in the Trace Verbosity field, 
enter a value from 1 to 100. 

A 1 is the highest priority. A 100 is the lowest priority. All messages whose trace verbosity value is 
equal to or less than the specified value are recorded in log files. A 30 is an optimal value that can 
be used in most cases. 

5. Click OK. 

The new trace mask appears in the right pane of Application Services Console. 

6. To modify an existing trace mask, in the right pane, right click a trace mask, select Properties, and 
make the required changes to the configuration. 

7. To delete a trace mask, in the right pane, right click a trace mask and select Delete. 

Configuring Application Services Options 
Application Services Console is also used for configuring miscellaneous Application Services options. 

To configure Application Services options, proceed as follows: 

1. In Application Services Console, in the left pane, select Console Root > Application Services 
Console > Options. 

All options are displayed in the right pane. 
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Figure 66: Configuring Application Services options 

The following table describes the Application Services options: 

Application Services options 
Option Description 
Use Parameterized Queries If selected, improves performance for high volume operations. 
Support Parallel Parcels If selected, enables support of parallel parcels. 

To improve performance, this option must be cleared if parallel parcels are 
not used. 

Update Parcel Props Table 
On Send 

Must be selected if the project uses the PARCEL_PROPS table and a 
correct NODE_ID value is important. 
This option is required if parallel parcels are used. 

Use Document Recycling 
Tables 

If selected, moves DOCUMENT table records to the DOC_RECYCLE 
table instead of deleting them. This option is required to support the 
Centera document storage. 

Configuration Cache 
Timeout 

Time in seconds for which retrieved workflow data is cached locally. 
The value must be increased if the database connection has high latency. 
Higher cache retention time reduces the network communication overhead 
and improves application performance. 

Automatically Unlink 
Documents on Deletion 

If selected, automatically unlinks documents from folders, parcels, or 
subfolders that are deleted. 
This option must be selected to ensure database consistency and simplify 
the application code. 

Smart Audit Event Filtering If selected, queries the audit filter before performing audited operations. 
This option must be selected to avoid expensive database queries where 
auditing is not necessary, and increase performance on high volume 
systems. 

2. To configure an option, in the right pane, right click the option and select Properties. 

The properties window appears. 
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3. Change the option value as appropriate. 
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Chapter 9: Installing Automatic Queue Server 
This section describes how to install Automatic Queue Server. 

Automatic Queue Server is an Exigen Workflow module for background processing of workflow items. 
Automatic Queue Server can be mapped to multiple custom scripts that implement customer-specific 
business logic. Access to workflow data store and actions with workflow items are performed via 
Application Services. 

For information on using Automatic Queue Server, see Chapter 21: Automatic Queue Server in Exigen 
Workflow Administrator’s Guide, Part 2: Business Component Reference. 

The following topics are described in this section: 

• Automatic Queue Server Requirements 

• Installing Automatic Queue Server from the Main Exigen Workflow Installation 

• Installing Automatic Queue Server from a Standalone Installation 

• Configuring the Number of Concurrent MSMQ Listener Threads 

Automatic Queue Server Requirements 
The following topics are described in this section: 

• Operating System Requirements 

• Required Components 

Operating System Requirements 
Automatic Queue Server uses the Message Queuing (MSMQ) technology, which is available in 
Windows 2000 and later Windows versions. Automatic Queue Server does not function on older 
Windows versions. 

Before using Automatic Queue Server, you must configure the database client to support Transaction 
Server as described in Chapter 10: Configuring the Database Client to Support Transaction Server. 

Required Components 
The following table lists all components required by Automatic Queue Server and describes how to 
install them: 

Automatic Queue Server required components 
Component Installation source 
Application 
Services 

Before running Automatic Queue Server, Application Services must be installed and configured 
as described in Configuring Application Services. 
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Automatic Queue Server required components 
Component Installation source 
MSMQ • In Windows 2000, MSMQ is an optional component and can be installed in the 

Add/Remove Windows Components window. 
• In Windows XP, MSMQ is included in the operating system. 
Unless there are specific requirements for MSMQ installation, MSMQ must be installed in 
workgroup mode. Integration with Active Directory® is supported but it requires advanced 
administrative operating system skills. For information on MSMQ, see the Microsoft support 
web site. 

.NET 
Framework 
Redistributable 

Download and install .NET Framework Redistributable and service packs from the Microsoft 
website: 

http://msdn.microsoft.com/netframework/downloads/updates/default.aspx 

MDAC Download and install MDAC from the Microsoft website: 

http://msdn.microsoft.com/data/ 

Installing Automatic Queue Server from the Main Exigen 
Workflow Installation 
To install Automatic Queue Server from the main Exigen Workflow installation, proceed as follows: 

1. Insert the Exigen Workflow installation CD into the CD drive. 

2. If the installation does not start automatically, from the CD, launch the Setup.exe file. 

3. Follow the installation instructions until you reach the Exigen Workflow window as described in 
General Installation Steps. 

4. In the Install/Upgrade column, in the Automated Services row, click Details. 
5. In the Automated Services window, in the Install/Upgrade column, select the Automatic Queue 

Server check box. 

http://msdn.microsoft.com/netframework/downloads/updates/default.aspx
http://msdn.microsoft.com/data/
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Figure 67: Installing Automatic Queue Server 

Automatic Queue Server requires that Application Services is installed. For information on installing 
Application Services, see Chapter 8: Installing Application Services. 

6. Click OK. 
7. Click Next. 

The Account information window appears. 
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Figure 68: Account information window 

8. In the Account information window, enter the following: 
• account name and password under which the Automatic Queue Server COM+ application is run 
• default database connection string 
• predefined configuration of registry settings for the database client to support Distributed 

Transaction Coordinator (MSDTC) 

The default account user name is visiflow and the password is exigensrv. 

9. To set up the required registry entries for the database client to support MSDTC, select the brand of 
your database client. 

The database brand can be selected only if Automatic Queue Server is not currently installed on the 
workstation. If there is a previous version of Automatic Queue Server installed on the workstation, 
the list of database brands is in read-only mode and cannot be modified. 

To change the selected database brand, the previous version of Automatic Queue Server must be 
removed. 

If None is selected, no registry entries are modified and the user must configure them manually if 
required. 

10. Click Next. 
11. To complete the installation, follow instructions as described in General Installation Steps. 
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Installing Automatic Queue Server from a Standalone 
Installation 
If you have a standalone Automatic Queue Server MSI installation file, it can be installed separately 
from Exigen Workflow. 

To install Automatic Queue Server using a standalone installation, proceed as follows: 

1. Make sure Application Services is installed on the workstation. 

For information on installing and configuring Application Services, see Chapter 8: Installing 
Application Services. 

2. Run the QueueServer.msi file. 

The Exigen Automated Queue Server Setup window appears. 

3. Click Next. 

The User information window appears. 

4. Specify the personalization information as required. 

5. Click Next.  

The Destination Folder window appears. 

 
Figure 69: Selecting the destination directory 
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6. In the Destination Folder window, click Browse and select the location to install Automatic Queue 
Server. 

7. Click Next. 

The Service account window appears. 

 
Figure 70: Specifying the account parameters 

8. In the Service account window, enter the account name and password under which the Automatic 
Queue Server COM+ application is run. 

The default account user name is visiflow and the password is exigensrv. 

If Automatic Queue Server handlers include a code that requires access to some shared resources 
in the local network, such as the remote file server, the Automatic Queue Server user account must 
have permission to access those resources. 

For example, if you must access files on a remote server from the Automatic Queue Server handler 
and the remote server is a member of some domain, the Automatic Queue Server COM+ 
application must be running under a user account that has access to the remote server. In this 
case, the usual approach is to use a service account with logon rights to that particular domain. 

9. Click Next. 
10. To complete the installation, follow the instructions. 



Installation Guide  Chapter 9: Installing Automatic Queue Server 

Copyright © 1994-2005, Exigen Properties, Inc. and/or affiliates. All rights reserved.   
Exigen Workflow 5.6 Page 120 of 128 

Configuring the Number of Concurrent MSMQ Listener 
Threads 
The maximum number of concurrent MSMQ listener threads defines the maximum number of 
Automatic Queue Server handler threads. By default, the value for this setting is calculated as follows: 

16 * <number of CPUs on the server> 

If the environment or Automatic Queue Server handler implies any restrictions, the setting must be 
changed. For example, in the Oracle database, the maximum number of concurrent distributed 
transactions may be required to be a smaller number. 

To configure the maximum number of concurrent MSMQ listener threads, proceed as follows 
depending on the operating system: 

• To configure the maximum number of concurrent MSMQ listener threads on Windows 2000, follow 
instructions as described in Configuring MSMQ Listener Threads on Windows 2000. 

• To configure the maximum number of concurrent MSMQ listener threads on Windows XP or 
Windows Server 2003, follow instructions as described in Configuring MSMQ Listener Threads on 
Windows XP and Windows Server 2003. 

Configuring MSMQ Listener Threads on Windows 2000 
To set the maximum number of concurrent MSMQ listener threads on Windows 2000, proceed as 
follows: 

1. Open Registry Editor. 

2. Create a registry key HKLM\Software\Microsoft\COM3\Debug. 

3. Add a new DWORD value named QCListenerMaxThread. 

4. Set the QCListenerMaxThread value to the required maximum number of concurrent MSMQ 
listener threads. 

The recommended value is 4. 

Note: This procedure sets the number of concurrent MSMQ listener threads for all applications on the server. 

Configuring MSMQ Listener Threads on Windows XP and 
Windows Server 2003 
To set the maximum number of concurrent MSMQ listener threads on Windows XP or Windows Server 
2003, proceed as follows: 

1. Select Start > Settings > Control Panel > Administrative Tools > Component Services. 
2. Locate and right click the EWF Automatic Queue Server application. 

3. In the pop-up menu, select Properties. 
4. Select the Queuing tab. 
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5. In the Queuing tab, set the required maximum number of concurrent MSMQ listener threads. 

Automatic Queue Server installation automatically sets this property to 4. 
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Chapter 10: Configuring the Database Client to 
Support Transaction Server 
This section describes how to configure the database client environment and Transaction Server to 
support Application Services and Automatic Queue Server functionality for several target database 
types. 

Application Services and Automatic Queue Server use Transaction Server as a transaction coordinator. 
In Windows 2000, Transaction Server is part of a standard Windows installation.  

If Exigen Workflow is installed on Windows Server 2003 or Windows XP SP2, the XA Transaction 
Support must be enabled as described in article KB817066 at the following website: 

http://support.microsoft.com/default.aspx?scid=kb;EN-US;817066 

It is recommended to use the latest available version of Data Access Components (MDAC). 

The following topics are described in this section: 

• Configuring the Database Client for Oracle Database 

• Configuring the Database Client for SQL Server 

• Configuring the Database Client for the DB2 UDB for iSeries 

• Configuring the Database Client for DB2 UDB 

• Application Services Connection String Examples 

Configuring the Database Client for Oracle Database 
To access an Oracle database, it is necessary to use the Microsoft ODBC driver for Oracle. The Oracle 
ODBC driver does not fully support Transaction Server. 

If Exigen Workflow is installed on Windows Server 2003 or Windows XP SP2, access must be granted 
to the Oracle folder for the NetworkServices account as described in article KB816633 at the following 
website: 

http://support.microsoft.com/default.aspx?scid=kb;en-us;816633 

For additional information on using Oracle with Transaction Server and COM+, see 
http://support.microsoft.com/support/complus/mtsandoracle.asp?SD=GN&LN=EN-US&gssnb=1. 

To configure the Distributed Transaction Coordinator (MSDTC) service, proceed as follows: 

1. Start Windows Registry Editor. 

2. Open the following registry section: 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\MSDTC\MTxOCI 

http://support.microsoft.com/default.aspx?scid=kb;EN-US;817066
http://support.microsoft.com/default.aspx?scid=kb;en-us;816633
http://support.microsoft.com/support/complus/mtsandoracle.asp?SD=GN&LN=EN-US&gssnb=1
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3. Configure the appropriate Oracle XA libraries by changing the appropriate registry string values for 
your Windows and Oracle versions as described in the following table: 
Oracle XA library registry strings 
Oracle Client Registry keys 
9.x "OracleXaLib"="oraclient9.dll" 

"OracleSqlLib"="orasql9.dll" 

"OracleOciLib"="oci.dll" 

10.x "OracleXaLib"="oraclient10.dll" 

"OracleSqlLib"="orasql0.dll" 

"OracleOciLib"="oci.dll" 

4. Restart the MSDTC service. 

Note: If there are any applications that depend on MSDTC, such as MSMQ, they may stop. 

5. If any applications stopped, restart them after MSDTC is restarted. 

6. If any problems occur with the Oracle server and distributed transactions, consider increasing the 
following Oracle server configuration parameter values: 
• sessions  
• distributed_lock_timeout  
• distributed_transactions  
• dml_locks  
• max_transaction_branches  
• open_cursors  
• processes  

• queuesize 

Configuring the Database Client for SQL Server 
Application Services and Automatic Queue Server function without any modifications with SQL Server 
with Service Pack 3, and no special configuration steps are required for the database client. 

Configuring the Database Client for the DB2 UDB for 
iSeries 
The following topics are described in this section: 

• Requirements 

• Configuring the Database Client 

Requirements 
For information on DB2 UDB for iSeries database client software requirements, see the Exigen 
Workflow readme file. 
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Configuring the Database Client 
To configure the database client to use the iSeries Access ODBC driver for Transaction Server, 
proceed as follows: 

1. To turn off the OLE DB session pooling for MSDASQL, proceed as follows: 
• Start Windows Registry Editor. 
• In the HKEY_CLASSES_ROOT\CLSID\{c8b522cb-5cf3-11ce-ade5-00aa0044773d}\ registry 

key, double-click the OLEDB_SERVICES value. 
• Change the OLEDB_SERVICES value to 0xfffffffc. 
• Close Windows Registry Editor. 

Warning: This is a global setting for the whole system and it may affect other applications.  

2. If you do not want to change a global setting, to achieve the same result, specify the OLE DB 
Services = -4; parameter in the connection string as described in Application Services 
Connection String Examples. 

This option affects only connections opened with this connection string. 

3. To turn on ODBC connection pooling, proceed as follows: 
• Open ODBC Administrator. 
• Select the Connection Pooling tab. 
• Double-click the 32-bit iSeries Access ODBC driver. 

The Set Connection Pooling Attribute window appears. 

• Select the Pool Connections to this driver option. 
• Set the timeout setting as required. 

A value larger than 60 seconds is recommended, but this setting depends on your specific 
system requirements. 

4. To set the required transaction isolation level, proceed as follows: 
• Open the iSeries Access Express ODBC setup window. 
• Select the Server tab. 
• Click Advanced. 
• Set the commit mode to *CHG. 

Configuring the Database Client for DB2 UDB 
The following topics are described in this section: 

• Requirements 

• Configuring the Database Client 

Requirements 
For information on DB2 UDB database client software requirements, see the Exigen Workflow readme 
file. 
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Configuring the Database Client 
To configure the database client to use Transaction Server, proceed as follows: 

1. To turn off the OLE DB Session Pooling for MSDASQL, proceed as follows: 
• Start Windows Registry Editor. 
• In the HKEY_CLASSES_ROOT\CLSID\{c8b522cb-5cf3-11ce-ade5-00aa0044773d}\ registry 

key, double-click the OLEDB_SERVICES value. 
• Change the OLEDB_SERVICES value to 0xfffffffc. 
• Close Windows Registry Editor. 

Warning: This is a global setting for the whole system and it may affect other applications.  

2. If you do not want to change a global setting, to achieve the same result, specify the OLE DB 
Services = -4; parameter in the connection string as described in Application Services 
Connection String Examples.  

This option affects only connections opened with this connection string. 

3. To turn on ODBC Connection Pooling, proceed as follows: 
• Open ODBC Administrator. 
• Select the Connection Pooling tab. 
• Double-click the IBM DB2 ODBC driver. 

The Set Connection Pooling Attribute window appears. 

• Select the Pool Connections to this driver option. 
• Set the timeout setting as required. 

A value larger than 60 seconds is recommended but this setting depends on your specific 
system requirements. 

4. To set the required transaction isolation level, proceed as follows: 
• Open the IBM DB2 ODBC setup window. 
• Click Advanced. 
• Select the Transaction tab. 
• Set the Isolation Level parameter to Serializable or Repeatable Read. 

Application Services Connection String Examples 
The following table provides examples of Application Services connection strings: 

Application Services connection string examples 
Type Example 
OLE DB provider for 
Oracle 

Provider=MSDAORA;Password=user_password; 

User ID=user_name;Data Source=ora_service; 

ODBC data source DSN=dsn_name;UID=user_name;pwd=user_password; 
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Application Services connection string examples 
Type Example 
OLE DB provider for SQL 
Server 

Provider=SQLOLEDB;Data Source=server_name; 

Initial Catalog=database_name; 

User ID= user_name;Password= user_password; 

It is possible to override the default services provided by OLE DB provider for ODBC by specifying the 
following settings in the connection string: 

Connection string default service override parameters 
Value in the connection string Services enabled 
OLE DB Services = -1; All services. This is the default value. 
OLE DB Services = -4; All services except pooling and automatic transaction enlistment. 
OLE DB Services = -5; All services except Client Cursor Engine. 
OLE DB Services = -8; All services except pooling, automatic transaction enlistment, and Client 

Cursor Engine. 
OLE DB Services = -3; Only pooling and automatic transaction enlistment services with a session 

level aggregation. 
OLE DB Services = 0; None. 

The following is a sample connection string with the OLE DB Services parameter: 

DSN=dsn_name;UID=user_name;pwd=user_password;OLE DB Services = -4; 
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